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1. Introduction 

The aim of this guide is to step through all the functional components of ITSM 
Bridge and its use in conjunction with Service Management Applications. This 
guide relates to release 3.10 of ITSM Bridge unless indicated otherwise.  

2. Audience and Scope 

This document aims to provide an overall understanding of all functionality 
within ITSM Bridge and how it can be used to support the migration of data 
between service management applications. It is aimed at any end-user that 
wishes to use the product and does not require any prior technical knowledge. 
It is assumed that the reader is familiar with the applications for which they are 
migrating data to and from. 

This guide assumes the following prerequisites: 

The product has been installed on a client machine with access to the source 
and target servers over a local network or internet connection. 

The user has administrator level access to both source and target applications. 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3. Definitions 

The following terms used to refer to different functionality within the product are 
referenced throughout this document:

The terms Fields and Forms are used throughout this document. Depending 
on the application reference, these may also be referred to as Columns and 
Tables.  For the sake of clarity, where applicable, wherever the term Field is 
used, substitute the word Column and wherever the term Form is used 
substitute the word Table.  These terms are interchangeable and synonymous. 

Term Meaning

Migration Project A collection of Form Mappings with various attributes 
that can be migrated from one application server to 
another in a single execution and in a specific order.

Mappings List A list of  Form Mappings presented in order of 
execution.

Form Mapping A collection of Field Mappings that define how data in 
a Source Form should be migrated to data in a 
specified Target Form or table.

Field Mapping Specific details on how a Target field within a Form 
mapping should be populated.  Field Mappings can be 
one of seven types (Simple, Assignment, Value Match, 
Reference, Lookup, List or ID Replacement)

Source Form The form from which data is to be migrated.

Target Form / Table The form or table to which data is to be migrated.

Template A Migration Project that cannot be executed.  
Templates are used as the basis for other Migration 
Projects.
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4. Pre-Requisites 

In order to run ITSM Bridge, you will need the following software on your client 
machine (no software is installed on the server): 

Java Runtime version 8 update 181 or later. 

Supported Client Operating Systems for installation: 

Windows 7, Windows 10, Windows Server 2003 or later 

Apple OS X Yosemite 10.10.5 or later. 

Memory Requirements 

We recommend a minimum of 8GB of RAM on the client machine where ITSM 
Bridge is installed.  If you are running very large migrations or migrations with 
lots of large attachments then we recommend either 16GB or 32GB depending 
on the volume and size and the number of parallel executions.  Also see 
advanced settings in the Launching and Licensing section below. 

Network Access

ITSM Bridge uses web services to connect to source and target servers.  if 
either of your servers are outside of your local network, you may need to adjust 
your firewall settings to ensure that you can send and receive SOAP 
messages to/from external systems.  By default web services/SOAP uses 
network port 443 to connect. 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5. Launching & Licensing 

To launch ITSM Bridge on a Windows 64 bit machine, unzip the 
ITSMBridgeWin<version>.zip file, run the setup.exe, then open the 
application called ITSMBridge from the Start->Programs menu, or click on the 
ITSMBridge icon on the Desktop.  

To launch ITSM Bridge on a Mac, unzip the ITSMBridgeMac-<version>.zip 
file, then open the file called runITSMBridge.jar (if this is the first time that you 
have opened the file, you may have to use the Ctrl->Open option.) 

The first time you launch ITSM Bridge, the licence properties screen will 
appear. 

!  

Enter your company name, contact name and phone number, licence type 
(Evaluation, Rental or Full Production) and activation date (the Client Host 
ID field should already be populated).  

Select one or more of the additional Licence Options: 
 Restrict to Same Server Type (e.g. ServiceNow -> ServiceNow) 
 Restrict to Same Server (Source and Target server must be the same) 
 Enable DB Source Server Add-on (for using an external DB source) 

Then click on the Request Licence button. 

A separate licence request screen is presented like this: 
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!  

Click on the Copy to Email button to launch your email client and send the 
request to licensing@itsmbridge.com in order to obtain your licence key. 

Once you receive your licence key, paste the full key into the first field 
provided in the Apply Licence Key window.  Then select the checkbox to 
confirm that you have read and accept the Licence Agreement and click on 
the Apply button next to the key.   If the key was entered correctly then you 
should see a message in the Licence Status section indicating that the 
product is fully licensed.  Click on the Close button to close the Licence 
screen. 

Evaluation Licences: 

If you have an evaluation licence, the product will operate with full 
functionality for the duration of the evaluation period (usually 10 days).  
However there is a restriction limit of 50 records per form mapping that can 
be migrated within any migration project. 

Rental Licences: 

If you have a rental licence, the product will operate with full functionality for 
the duration of the rental period.  There are no restrictions on the number of 
records that can be migrated. 

Initial Configuration 

The first time you launch ITSM Bridge you will be presented with a 
configuration screen like this: 
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If you are planning to migrate to or from a Remedy AR System server then 
you must click on the checkbox for ‘Support AR System Servers’ and 
provide the path to the ARSystem API Library.   If you have any AR System 
client or server applications installed (in the default location) the path to the 
API Library (lib) folder will be automatically set.  If the path remains blank or 
you want to use a different location, use the Browse button to navigate to it.  
The following java libraries are required depending on your version of AR 
System: 

AR System Version Library Files

7.6.04 arapi764_build002.jar 
arapiext764_build002.jar 
ardoc764_build002.jar 
log4j-1.2.14.jar

8.1 arapi81_build001.jar 
arapiext81_build001.jar 
ardoc81_build001.jar 
log4j-1.2.14.jar

AR System Version
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If you have a different version of AR System to those listed above, the files 
required should have a similar format, e.g. arapi<version>_build001.jar.  Set 
the path to the location of these jar files on your local machine. 

Enabling Support for Oracle Data Source 

If you have an ITSM Bridge license that allows selection from a DB Source 
Server (see above) and you want to use an Oracle database as your source 
then you must enter the location of the Oracle JDBC Driver on your local 
machine. 

If the driver is not present on your local machine, it can be downloaded from 
the Oracle Website at www.oracle.com/technetwork/database/features/
jdbc/index-091264.html. 

First, check the 'Support Oracle Data Source' checkbox. Use the Browse 
button to navigate to the file. It will be named either ojdbc6.jar (for Oracle 11) 
or ojdbc7.jar (for Oracle 12).   The location is then passed to ITSM Bridge on 
start up. 

You must have a network connection from your local machine to the Oracle 
database that you want to use as a source. 

Enabling Support for SQL Server Data Source 

The SQL Server JDBC drivers required to connect to a SQL Server database 
are not distributed with ITSM Bridge . You can specify the location of these in 
the configuration tool. If not present on the local machine, this file can be 
downloaded from the Microsoft Website (https://www.microsoft.com/en-us/
download/details.aspx?id=11774). In the configuration tool, navigate to ...
\sqljdbc_4.2\enu\jre8\sqljdbc42.jar. This location is then passed to ITSM 
Bridge on start up. 

First, check the 'Support SQL Server Data Source' checkbox. Use the Browse 
button to navigate to the file. It will be named sqljdbc_4.2 This will support 
SQL Server 2008 through to 2012 

9.1 arapi91_build001.jar 
arapiext91_build001.jar 
ardoc91_build001.jar 
log4j-1.2.14.jar

Library FilesAR System Version

http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html
https://www.microsoft.com/en-us/download/details.aspx?id=11774
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Advanced Settings 

You can specify the initial memory and the maximum memory that the ITSM 
Bridge application will use.  These may need to be increased from the 
defaults if you run a large project, particularly one containing: 

a) attachment data mappings; 
b) a very large number of records (> 1,000,000) 
c) a large number of reference mappings or inclusion filters, particularly if 

large volumes of data are being migrated. 

You should be sure that your machine can support the defined memory 
requirements to avoid memory allocation issues when starting up ITSM 
Bridge. 

Optionally you can also define other Java Virtual Machine parameters to be 
passed on start up.  Use this option only if you are experienced in JVM 
configuration. The settings are stored in a folder named ‘ITSMBridge’ in your 
Local Application data folder (Windows) or User.home (OS-X). 

The configuration settings can be changed from within the ITSM Bridge 
application if necessary by selecting Configure… from the File menu. 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6. Opening an Existing Migration Project 

Before you can start a migration, you must create a new project or open an 
existing one using the File menu. 

!  

When opening an existing project, a file browser screen will be presented.  

Select the folder with the project name that you want to open.  After opening 
the project a new screen will be presented as shown below with the details of 
the project source and target servers: 

!  
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Check that the Source Server Type and Target Server Type are correct (both 
set to Remedy if you are migrating between Remedy servers). 

Enter the Source Server Name, User Name and Password.  Note that this 
must be a user with Administrator level access to the Remedy or ServiceNow 
application.   If necessary enter the Port Number required to access the 
Source server.  See separate section below on configuring an Oracle 
database source. 

Next enter the same details for the Target server where the data will be 
migrated to.  Again the account must have administrator level access to the 
Remedy or ServiceNow application. 

If you want to retain the login details for each server, select the Save 
Authentication option.  After selecting this option, the username and 
password are stored and do not need to be entered again the next time you 
open the same project from the same client machine.  Otherwise you will 
need to re-enter them each time you open the project. 

In order to check that the relevant servers can be accessed using the 
credentials provided, click on the Test button on the right for each server.   

If the selected server is reachable then a confirmation message will be 
displayed.  If the server is not reachable then a failure/timeout message will 
be displayed.  Correct the Server name, User Name and Password and try 
the test again.  If the server is still not reachable, try using the IP address of 
the server instead.  Also check that you can connect to the server from your 
client machine without using ITSM Bridge. 

Once access to both servers is confirmed, click on the Open button to open 
the project definition.   A dialogue is then presented at the bottom left of the 
screen indicating that the product is establishing Source Connection and 
Cache, then Target Connection and Cache, which may take a few seconds.  
Then the name of the project should appear at the top of the left pane with 
the version number in brackets like this: 
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The project details can now be accessed either using the Project menu, or 
by right-clicking on the My Project text in the left pane. 

Opening a Recent Project 

To open a recently opened project, select File->Open Recent from the menu 
then select the project name. 

Configuring an Oracle Database Source 

If you have an ITSM Bridge licence which includes the database source 
server add-on then you can configure ITSM Bridge to use an Oracle 
database as your data source. 

Firstly check that you have setup the path to the corresponding JDBC driver 
(under File->Configure). 

Once this has been set, select Oracle DB as your Source Server Type: 

!  

Then enter the Source Connection details for your Oracle database: 

Data Source:  The name of your Oracle server or IP address 
Service Name: The name of the oracle service 
Port:   The port number for this service (default 1521) 
User Name:  The name of the oracle user to connect with 
Password:  The oracle password for this user 
Schema:  The schema for which you want to limit table read access 
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Note that if Schema is left blank then all tables owned by the connected user 
are presented within ITSM Bridge for data mappings.  If Schema is set to 
‘ALL’, then all tables including system tables that the user has read access to 
are presented within ITSM Bridge for data mappings.  See Appendix G for 
restrictions on use of Oracle DB as a data source. 

Configuring a SQL Server Database Source 

If you have an ITSM Bridge licence which includes the database source 
server add-on then you can configure ITSM Bridge to use a SQL Server 
database as your data source. 

Firstly check that you have setup the path to the corresponding JDBC driver 
(under File->Configure). 

Once this has been set, select SQL Server DB as your Source Server Type: 

Then enter the Source Connection details for your SQL Server database: 

!  

Data Source The name of your SQL Server server or IP 
address

Database Name The name of the SQL Server database

Port The port number for this service (default 1433)

User Name The name of the SQL Server user to connect 
with

Password The SQL Server password for this user

Schema The schema for which you want to limit table 
read access
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Note that if Schema is left blank then all tables owned by the connected user 
are presented within ITSM Bridge for data mappings.  If Schema is set to 
‘ALL’, then all tables including system tables that the user has read access to 
are presented within ITSM Bridge for data mappings. 

7. Creating a New Migration Project 

To create a new project from scratch, select File->New->Project option from 
the File menu. 

!  

After selecting New Project option from the menu, the new project details 
window is displayed.  This is the same as the window displayed when 
opening an existing project (see previous section), except that the Open 
button is replaced by a Create button.   After entering the server details, use 
the Test buttons to confirm connectivity before clicking on the Create button. 

After selecting Create, a dialogue is presented at the bottom left of the screen 
indicating that the product is establishing Source Connection and Cache, 
then Target Connection and Cache, which may take a few seconds.  Then the 
name of the project should appear at the top of the left pane with the version 
number [1] in brackets. 

DB Type The type of database you are connecting to, 
either Sharepoint 2010 or ‘Other’
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8. Creating a New Template Project 

Template projects operate in exactly the same way as regular projects with 
the exception that they cannot be executed.  If you have a set of form 
migrations that you want to re-use on multiple projects then it makes sense to 
store them in a template.  You can then base one or more new projects on 
this template and execute those projects separately. 

To create a new template, select File->New->Template from the menu. 

!  

The new template properties window is then presented like this: 

!  
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Enter the server details, administrator user names and passwords and click 
Create to create the Template.   Select the Save Authentication option next to 
each server to retain the login details for this template.  

Note: Template projects are displayed in the left pane with a blue ’T’ next to 
the name to identify them.  Additionally, when you save a template the project 
folder is automatically prefixed with _TEM_ to distinguish it from regular 
projects. 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9. Creating a Migration Project from a Template 

In some cases, it may be preferable to base your project on an existing 
template rather than creating it from scratch. We provide a range of templates 
for different types of migration. 

!   

To create a new project from a template select File->New->Project From 
Template then select the template that you want from the list of sub-menus.   
If you have previously created your own custom template, then use the 
Browse… option to manually select the template file. 

!  

After selecting the template, the project properties window is displayed as 
above.  Use the create button to create the new project.  All the mappings 
from the template will then be transferred into the list of mappings for this 
project ready for use.  They can be customised as necessary to suit the 
needs of individual projects. 

Warning: The templates provided with ITSM Bridge are examples only and 
should not be relied upon to provide a complete end-end solution.  They 
can be used as the basis for a project and should be amended and 
extended as necessary to meet your own particular requirements.
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10. Using File Save, Save As, Move and Rename Options 

File->Save Option 

Whenever you make changes to a project or template, use the File-Save 
option to save your changes.  When the project is saved, the version number 
is automatically incremented and shown in brackets after the project name 
and in the header panel.  All projects are saved prior to execution. 

If there are any unapplied changes detected then you will be prompted to 
apply those changes as part of the save operation.  

File->Save-As Option 

You can use the File-Save As option to save the project in a different location 
(whilst retaining the original copy).  When you select this option, the following 
dialogue window is displayed (see below). 

Firstly change the project name (if required) and select a new location for the 
project using the Browse button. 

The following Project Copy Options are then available for selection: 

Retain Version Numbering:  Keeps the current version number for the 
copied project.  If you don't select this option then the copied project will 
revert to version 1. 

Copy Version History:  Copies all previous versions of the project to the new 
project folder, (only applicable if you have selected Retain Version 
Numbering) 
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!  

Copy Project Settings: Retains all the Execution Settings for the current 
project in the copied project. 

Copy ID Mapping Cache History:  If you have used Server Defined Record 
IDs as a Key Mapping option on any of your Form Mappings then a historical 
record of these record ID mappings are stored against the project.  If you 
want to make use of these for future migrations with the new project then you 
should select this option to have the mapping history copied over to the new 
project. 

Copy Project Log:  Copies the historical log of all project updates to the 
copied project. 

Copy Execution Logs:  Copies the logs of all migration executions for the 
current project to the copied project. 

Copy Execution Reports:  Copies the execution reports from all migration 
executions for the current project to the copied project. 

File->Move Option 

If you want to move a project (and its entire folder structure) to a new 
location, select the File->Move option from the menu. 

After you select this option, a dialogue window is displayed which allows you 
to select a new location.  Use the Browse button to select a new folder 
location.  After selecting a new folder location, the entire project including all 
previous versions, logs and reports are moved to the new location. 
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!  

File->Rename Option 

The Rename option is not only used to change the name of a project but can 
also be used to change the project type (from Standard to Template). 

After selecting File-Rename, the following dialogue window is displayed: 

!  

Enter the new name for the project, then optionally change the Project Type 
to Template Project.  (See separate section on Template Projects above).  
After renaming the project, the name of the project folder is updated and the 
project folder structure is retained. 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11. Entering Project Notes 

To enter notes about a particular project, select the Notes tab on the Project 
Properties screen when you create or open the project.  Alternatively if the 
project has already been created/opened, select Properties from the Project 
menu, then select the Notes tab.  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12. Creating a New Mapping 

To create a new mapping for an existing project, select New Mapping from 
the Project menu or right-click on the project name in the left pane and 
select New Mapping.   A new mapping window is then presented like this: 

!  

Target and source forms can be selected in two ways: 

a) using the menus against the form name fields to select from a full list of 
forms; 

b) using the buttons to the right of the form fields to search for the form 
name using full form details and results filtering. 

For example, clicking on the button to the right of the Target Form or Source 
Form, brings up a new search window like this: 

!  
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By default, a full list of forms sorted by Label / Name is displayed with their 
form types and properties. 

To sort by Form Type instead of by Label, click on the top of the Type column. 

To restrict (filter) the list of forms, you can use one or more of the filters at the 
top of the window. 

To restrict the form list by Label/Name, enter part or all of the form name then 
click on the Apply Filter button.   Only those forms that start with matching 
label/name text are listed. 

To restrict the form list to a particular Form Type (e.g. Regular, Dialog, Join, 
View or Vendor), select the corresponding type from the Type field and click 
on the Apply Filter button.   Only those forms with matching Type are listed. 

To restrict the form list to a particular mapping status (mapped or unmapped), 
select the corresponding mapping status from the Mapping Status field and 
click on the Apply Filter button.  Only those forms with matching mapping 
status are listed. 

The restrict the form list to any combination of the above, simply select values 
from one or more of the filter fields and click on Apply Filter button. 

To clear an existing filter, click on the Clear Filter button. 

Once you have identified the form that you want, click on the corresponding 
row in the table and then click on the Select button.  The selected form is 
then displayed as the Source or Target Form for the new data mapping. 

!  
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The Identifier field is used as a reference for the Form mapping.  A default 
value is automatically provided based on the Target Form Name.  You can 
change the Identifier but it must be unique within this project. 

Once both the source and target forms have been selected (with a unique 
identifier), click on the Create button to create the new mapping.  

After creation, the mapping becomes part of the project definition and is 
stored in the project tree in the Navigation Pane under the name of the 
mapping project. To view the mapping expand the project tree in the left pane 
by clicking on the arrow next to the project name: 
 

Note that the data mapping in the project tree is given the name of the 
Mapping Identifier (CTM:LoadPeople in this case) for reference purposes.  
As more mappings are created, they are added to this tree in the order that 
they are created.  The mapping order can be changed if required (see 
Managing the Mapping List below). 

Mapping to Virtual Tables 

Virtual tables are used to run a script on the ServiceNow transform map to 
perform a migration that cannot be done through a standard table mapping. 

When using virtual tables, only the import set migration option is allowed and 
they can only be used for ServiceNow->ServiceNow migrations. The script 
itself determines if business rules are run and whether to create or update 
when the target entry exists or not. 

The following virtual tables are provided as targets in the New Mapping List: 
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#!JOURNAL ENTRY MIGRATOR!# 
#!WF ACTIVITY VARIABLE VALUE MIGRATOR!# 
#!VARIABLE VALUE MIGRATOR!# 

The Journal Entry Migrator virtual table is used to run a script using input 
from a source Journal Entry table so that the entries are created in the correct 
order and with the correct usernames and timestamp on the journal entries 
for comments and work notes. 

When mapping to this virtual table the following fields should be set: 

For example if you want to migrate Journal Entries for the Incident table, first 
create a mapping from Incident to Incident; ensure that the created field is 
mapped and that the migration method is set to Import Set (Scripted).  This is 
important as it needs to match the create date on the original incident for the 
journal entries to be displayed correctly. 

Finally create a mapping from the Journal Entry table to the Journal Entry 
Migrator Virtual table using the values defined above. 

The above mappings are provided in the Incident and Problem migration 
template for ServiceNow->ServiceNow migrations. 

The Workflow Activity Variable Value Migrator virtual table is used to run a 
script to migrate workflow activity variable values from the source to the target 
instance.  It migrates from the source sys_variable_value table to create the 
corresponding variable values for the target workflow activity table.  Note that 

Target Field Mapped Value

Parent ID the sys id of the parent record (use a reference 
mapping of the parent record)

Parent Table the name of the parent table (e.g 'incident', or 
can map to the 'name' source field)

Field Name map to the 'element' field

Entry Text map to the 'value' field

Created On map to the  sys_created_on field

Created By map to the sys_created_by field

Add Audit Entry True' (if the journal entries are displayed in an 
activity field you need audit records created as 
well)
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the workflow activity that the variables relate to should be migrated prior to 
this migration. 

When mapping to this virtual table the following fields should be set: 

An example of this mapping is provided in the Workflow Definitions template 
for ServiceNow -> ServiceNow migrations. 

Target Field Mapped Value

Model Name the name of the workflow activity definition 
(use a lookup to retrieve this from the 
wf_activity_definition table);

Parent ID the SysID of the target workflow activity 
definition record (use a reference mapping to 
retrieve this)

Activity Variable Name the name of the activity variable (use a lookup 
to retrieve the element field from the 
wf_activity_variable table

Parent Table map to the 'table' field

Value map to the 'value' field

Order map to the  ‘order’ field
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The Variable Value Migrator virtual table is a more general version of the 
workflow variable value migrator.  It can be used to migrate variable values 
that belong to any parent table.  The source table should be the 
sys_variable_value table.   Note that the parent table that the variables relate 
to must be migrated prior to this migration. 

When mapping to this virtual table the following fields should be set: 

Target Field Mapped Value

Parent ID the SysID of the target parent record (use a 
reference mapping to retrieve this)

Variable ID the name of the variable (use a lookup to 
retrieve this from the parent table);

Parent Table map to the 'table' field

Value map to the 'value' field

Order map to the  ‘order’ field
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13. Managing the Mappings List 

Once you have created one or more mappings you can view of the list of 
mappings in two ways: 

a) by selecting View Mappings List from the Project Menu; 
b) by right-clicking on the project name in the Navigation pane and selecting 

View Mappings List; 

The mappings list for the current project is then displayed in the right pane 
like this: 

!  

The first column in the Form Mapping List is reserved for highlighting 
differences between field definitions on source and target forms resulting from 
the Difference Report.  See Reporting section for more information on how to 
run this report. 

Creating a New Form Mapping from the Mappings List 

In addition to the method of creating a New Form Mapping described above, 
you can also create new form mappings using the New button at the bottom 
of the Mappings List window.  New form mappings automatically get added to 
the bottom of the list.   

Changing the Order of the Mappings List 

To change the order of any mappings in the list, select the corresponding row 
then click on the arrows on the right of the Mapping List window to move the 
mapping up or down in the list.  Moving a mapping in this way will 
automatically update the order number on the left of the window. 

Deleting a Form Mapping from the Mappings List. 
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In order to delete a mapping from the mapping list, select the corresponding 
row, then click on the Delete button at the bottom right of the Mapping List 
window. 

Whenever the Mapping List is updated, the project tree in the Navigation 
pane is also updated to reflect the changes made. 

Changing the Mapping Identifier 

To change the mapping Identifier, select the corresponding Form Mapping 
from the list then click on the Change Identifier button at the bottom of the 
Form Mapping List. 
 

Enter a new Identifier for this mapping then click on OK to save.  Note that 
the Identifier must be unique within the current project. 

Enabling and Disabling Form Mappings 

All form mappings in the mapping list are automatically enabled by default.  
To disable a form mapping, click on the checkbox in the Enabled column for 
the corresponding form mapping to de-select that form mapping.  The form 
mapping is then greyed-out in the mapping list (and in the navigation pane), 
and will be excluded from the migration. 

The same result can be achieved by de-selecting the Enabled checkbox in 
the Options tab for the corresponding form mapping, or by right-clicking on 
the form mapping within the navigation pane and selecting Disable/Enable. 

To Enable/Disable more than one form mapping at once, select multiple form 
mapping rows using the Shift Key, then click on the Enable or Disable buttons 
on the bottom right of the Mapping List. 

On execution, Form Mappings are skipped if disabled, however if a reference 
mapping refers to a disabled Form Mapping, the ID mapping cache for the 
disabled Form Mapping is still built, so that the reference can be obtained. 
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Handling Invalid Form Mappings 

If after opening an existing project, any of the target forms/tables do not exist, 
the corresponding form/table names are highlighted in red like this: 
 

To remove these mappings, follow the instruction in the section above - 
Deleting a form mapping from the list. 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14. Defining Field Mappings 

In order to view or edit the field mappings for a given Form Mapping you can 
either: 

a) Double-click on the corresponding mapping in the Project Tree in the left 
pane or 

b) Double-click on the corresponding row in the Mapping List window in the 
right pane or 

c) Click on the View/Edit button at the bottom of the Mappings List. 

If this is the first time that you have opened this mapping there may be a 
short delay of a few seconds while the field definitions are cached.  A 
message is displayed in the left corner of the screen to indicate this. 

A separate window is then displayed in the right pane (see below) which 
allows field mappings to be defined or updated.  A full list of all fields from the 
target form are displayed by default, sorted by the Target Field Name. The 
Target Field Label and Target Field Type are also displayed.    All required 
fields are displayed using a star symbol in the second column. 

!  

If a field has already been mapped to a field on the source form, then the 
Mapping Type and Source field are also displayed in the list.    

To change the sort order of the field list, click on the corresponding column 
heading to sort by that column.   To reverse the sort order, click on the column 
heading again (the fields are then listed in reverse alphabetical   order). 

The first column in the Field Mapping List is reserved for highlighting field 
differences between source and target forms resulting from the Difference 
Report. (see Reporting section for more information on how to run this 
report). 
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To filter the list of fields in the Field Mapping List, click on the Filter List 
button on the top right of the window.  A new window is displayed which 
allows the user to select one of more filters from the following: 

Mapping Status (All Unmapped, All Mapped, All Mandatory, Mandatory 
Mapped, Mandatory Unmapped); 

Mapping Type (Simple, Assignment, Value Match, Reference, Lookup, ID 
List, ID Replacement) 

Target Type (Integer, Real, Character, Diary, Enum, Timestamp, Decimal, 
Attachment, Currency, Date, Time) 

Target Field (Free text) 

Source (Free text) 

!  

To apply a filter, enter a value in one or more of the filters above and click on 
the Apply Filter button.  The resulting list of fields is displayed below based 
on the values entered.   

To clear the current filter, click on the Clear Filters button.  The filter fields  
pane then disappears and the original unfiltered field list is displayed.  

There are seven different types of field mapping that can be created (Simple, 
Assignment, Value, Reference, Lookup, ID List and ID Replacement).  These 
are described in more detail in the following sections. 
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Creating a new Simple Field Mapping 

Simple field mappings are used to map a field from the source form to a field 
on the target form without any manipulation of the field value. 

To create a Simple Field Mapping, first select the Target Field from the list of 
fields in the Field Mapping List, then select Simple from the New Mapping 
field below. 

!  

When you select Simple from the New Mapping field, a new screen is 
presented with the name of the target field displayed at the top in bold.  To 
map a field from the source form, just select from the menu on the Source 
Field and click the Apply button. 

!  

If necessary, you can also define a Default value to use in the event that the 
source field value is null. 

If its not clear which Source Field value to select from the menu, click on the 
button to the right of the Source Field to reveal a more comprehensive list of 
fields with filtering options like this: 
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!  
Comprehensive List of Source Fields with Filtering 

To restrict the list of fields, enter a value in one or more of these Filters:   

Name/ID (Free text) 
Mapping Status (Mapped / Unmapped) 
Type (Integer, Real , Character, Diary, Enum, Timestamp, Decimal,    
Attachment, Currency, Date, Time) 
Mandatory (Checkbox) 

Then click on the Apply Filter button  

To clear the filter and display the full list of fields on the Source form, click on 
the Clear Filter button. 

Once you have identified the field you want to map, select the corresponding 
row in the table and click on the Select button.  The original mapping screen 
is then displayed with this value populated in the Source Field.  Click on the 
Apply button to apply the mapping. 

Once the mapping is applied, it appears in the Mapping List table with the 
Mapping Type (Simple) and the Source Field value. 

Creating a new Assignment Field Mapping 

Assignment Field Mappings are used whenever any manipulation or 
conversion of the Source field value is required. It can also be used to 
combine one or more Source field values or to set or combine literal values. 
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To create a new Assignment Field Mapping, first select the Target Field from 
the list of fields in the Field Mapping List, then select Assignment from the 
New Mapping field below.  A new screen is then presented with the name of 
the target field displayed at the top in bold: 

!  

If there is an error during execution of the migration for this mapping, you can 
define how the error should be handled using the On Error Action field.  The 
options available are: 

If Set Default is selected then the Default value must be provided in the field 
next to the On Error Action field. 

The source field value(s) is/are converted to the target field value using an 
Expression Builder.   This allows you to define an expression that 
determines how the source value(s) should be converted. Click on the 
Expression Builder button to launch the expression builder screen:  

On Error Action Description

Set Null: Sets the target field value to Null;

Skip Record: No target values are set for this record, skips 
to the next record;

Log Error: No target value is set but an error is recorded 
in the log.

Set Default: The Default value is used to set the target field 
instead.
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!   

To build an expression, first select the Source field using the menu on the 
Source Field, then click the Add button to add it to the Expression.  If its not 
clear which source field to choose, click on the button to the right of the Add 
button to bring up the comprehensive field list with filtering options.  (Refer to 
the section above on Creating a Simple Field Mapping for more details on 
how to use the comprehensive field list). 

You can use any combination of the following Keywords when constructing 
your expression by selecting them from the Keyword field and clicking the 
Add button on the right: 

NULL: Converts to the NULL string during execution; 
DATE: Converts to the current date during execution;  
TIMESTAMP:  Converts to the current date and time during execution; 
TIME: Converts to the current time during execution; 

Use the bracket buttons to group different parts of the expression together to 
avoid any ambiguity. 

Use the ‘str’ button to add a literal value to the expression like ‘000’ or ‘COM:’ 
There are five operators that you can use to combine or change the value of 
an expression as follows: 
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In addition there are a number of Functions that can be used to manipulate 
Source field values.  These can be selected using the Function menu and 
added to the expression using the Add button to the right.  A detailed 
summary of the Functions available with examples is provided in Appendix A. 

Some example expressions (without functions) are provided here: 

Example 1: 

[Company] + '(' + [Company Abbreviation] + ')' 

Adds two Source Field values together, the second of which is enclosed in 
brackets.  Note that the source field names are enclosed by square brackets 
and literal values are enclosed with single quotes. 

Example 2: 

(TIMESTAMP + ((60 * 60) * 24)) 

Sets the target field to the current time plus 24 hours. 

Example 3: 

Operator Description

+ Used to add two strings together OR to add two 
integers/decimals/real values together OR to add an 
offset (in days) to a date value OR add an offset (in 
seconds) to a date-time or time value.

- Used to subtract one integer/decimal/real value from 
another OR to subtract an offset (in days) from a 
date value OR subtract an offset (in seconds) from a 
date-time or time value.

* Used to multiply two integer/decimal/real values 
together

\ Used to divide one integer/decimal/real value by 
another

MOD Used to calculate the remainder when one integer is 
divided by another.
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‘Reserved’ 

Sets the target field to the literal value ‘Reserved’. 

You can also supplement your expression with temporary variables.  Note 
that temporary variables must have been defined and mapped in advance.  
For more information on creating and using temporary variables see the sub-
section on temporary variables towards the end of this section. 

When you have completed entering your expression, use the Validate button  
on the right to check that the expression is valid.  If necessary you can use 
the Revert button to return to the last expression entered before you 
validated or applied any changes. 

Once the expression is validated, use the Apply button to apply and save 
the expression which will then be used to set the target field value during 
execution. 

Creating a new Value Match Field Mapping 

Value Match Field Mappings should be used whenever the selected source 
field has a distinct set of values that need to be mapped to different values on 
the target. 

To create a new Value Match Field Mapping, first select the Target Field from 
the list of fields in the Field Mapping List, then select Value Match from the 
New Mapping field below.  A new screen is then presented with the name of 
the target field displayed at the top in bold: 

!  

Firstly select the source type (either Source Field or Temporary variable).  If 
you select Source Field the select the field from the Source Field menu 
below.  If its not clear which source field to choose, click on the button to the 
right of the Source Field to bring up the comprehensive field list with filtering 
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options.  (Refer to the section above on Creating a Simple Field Mapping for 
more details on how to use the comprehensive field list). 

Once the Source field is selected, if it is an enumerated type, the list of valid 
values for this field are displayed in the table on the right (in the column 
called Source Display Values).   If the source field is not an enumerated 
type then you can enter the values that you want to map as free text. 

If you select Temporary Variable for the Source Type then you must select 
one of the temporary variables that you have defined for this Form Mapping, 
(see separate section on Creating Temporary Variables). 

!  

In the event that the Source Field value or Temporary Variable value does not 
match any of the values that you have defined for this mapping, then you can 
use the ‘On No Match’ field to define the behaviour in this case.  The options 
available for the ‘On No Match’ field are as follows: 

On No Match Action Description

Set Null Sets the target field value to Null;

Skip Record No target values are set for this record, skips 
to the next record;

Log Error No target value is set but an error is recorded 
in the log.

Set Default The Default value is used to set the target field 
instead.

Use Source The target field is set to the value of the source 
field.
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Next, click on the Map Fields button to navigate to the Value Editing tab. 
This tab allows you to define the target values that you want to map to for 
each of the source values that the source field or temporary variable can 
take.   

In this example we have selected the Status field which has six pre-defined 
values, (Proposed, Enabled, Offline, Obsolete, Archive, Delete).  For each 
value, enter a corresponding target value using the Target Field and use the 
Add button to add to the table. 
 

The target values can either be the same as or different to the source values.  
If you make a mistake, you can use the Update or Remove buttons to modify 
the table mappings.  

If there are a lot of Source or Target values and you need to search for a 
specific value to use, click on the button to the right of the Source or Target 
value menu to bring up the Search window: 
 
To restrict the list of values displayed in this table, enter a Value/Display Label 
and/or a Mapping Status (Mapped or Unmapped), then click on the Apply 
Filter button.  To return to the full list of field values, click on the Clear Filter 
button.   Once you have identified which value to use, select the 
corresponding row from the table and click on the Select button.  This will 
then return you to the main value mapping screen. 

If you want to map a character field that is not enumerated, you can simply 
enter the free text values instead.  In the example below, the field values both 
source and target are entered as free text and added to the table using the 
Add button. 
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!  

Once you have finished setting up your field value mappings, use the 
Validate button on the right of the table to check that the values provided are 
all valid without saving the changes.  The system will identify any invalid 
values (for enumerated fields) and give you the opportunity to selectively 
remove them.  Once you are finished, use the Apply button to apply and 
save the field value mappings.   To revert to the previous set of value 
mappings for this field use the Revert button. 

To restrict the list of values displayed in the mappings table, click on the 
Table Options tab. 
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The table options can be changed if the source or target value is an 
enumerated field type.  By default all rows in the mappings table are 
displayed.  To restrict to just mapped or just unmapped values, select the 
corresponding Display Rows For option.   

For enumerated fields, you can choose to display either the Display Label or 
the Value for that field.  For example, the Status field might have a Display 
Label of ‘Proposed’ with a corresponding stored Value of ‘0’.  After changing 
the Show Source or Show Target settings, the Field Mappings table is 
automatically updated to show the field values using the specified format. 

Creating a new Reference Field Mapping 

Reference Field Mappings should be used whenever the Target Field needs 
to be populated from the primary key field used in a previous mapping.  For 
example, if you are creating a mapping for the CTM:People form, the Site-ID 
field should be populated from the Site-ID used in a previous mapping for the 
Site form. 

To create a new Reference Field Mapping, first select the Target Field from 
the list of fields in the Field Mapping List, then select Reference from the 
New Mapping field below.  A new screen is then presented with the name of 
the target field displayed at the top in bold: 



Copyright Service Management Integrations Limited. 2015-2018.                    
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/
or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. 
BMC and Remedy are registered trademarks of BMC Software Inc.  SQL Server and 
associated logo are trademarks of Microsoft.  Oracle and Java are registered trademarks of 
Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Document Version: 
3.10.2 

Date: Oct 2018 
Page !  48

ITSM Bridge Product User Guide                 !  
——————————————————————————

!  

Select the Source Field value from the drop-down list or use the button to 
the right of the Source Field menu to search for the Source Field using the 
comprehensive field list with filtering options.   (Refer to the section above on 
Creating a Simple Field Mapping for more details on how to use the 
comprehensive field list).  In the above example we have selected the Site-ID 
from the Source form for the current mapping. 

Next, select the key mapping using the menu on the ‘Use Key Mapping 
from’ field.  This provides a list of all previous mappings (with lower execution 
order than the current mapping).  Using the above example, the key mapping 
would be a mapping with Identifier SIT:Site. 

By default, the record ID from the Target record is returned (in this case the 
Site-ID), where the field value on the Source record matches the Source field 
value selected above. 

If you want to return a different field from the Target record, use the option 
Populate Using Mapping For field, then select the field that you want from 
the drop-down list. 

If there is no matching value you can define what action to take using the No 
Match Action field.  The options available are summarised in the table 
below.   

If Set Default is selected then the default value must be provided in the field 
below the No Match Action field. 

No Match Action Description

Set Null: Sets the target field value to Null;

Skip Record: No target values are set for this record, skips 
to the next record;

Log Error: No target value is set but an error is recorded 
in the log.
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Similarly, you can control the behaviour if multiple matches are found using 
the Multiple Match Action Field.  These are the same as for the No Match 
Action field with the additional option of ‘Use First’.  If this option is selected 
then the first matching record is used to set the target value. 

Once you have selected the mapping, click on the Validate button to validate 
the selection without saving.  Then click on the Apply button to apply and 
save your changes.  If necessary, you can use the Revert button to revert 
back to the previous state of this mapping before the last validation. 

If the Key Mapping uses ‘Server Defined Record ID’ and the option to 
support use of Instance ID Reference has been selected then you may select 
the option ‘Source Field references the “InstanceId’ field’  as shown below. 

!  

In this case, the Source Field selected should hold the value of the Instance 
ID which is then used as a reference to identify the record in the form 
selected in the ‘Use Key Mapping from’ field. 

Notes on use of Key Mapping in Reference Field Mappings 

1. If the Key mapping  uses  ‘Server Defined  Record ID’ , no match will 
be found UNLESS a source record with the same ID that is referenced 
was previously successfully migrated (either in this execution or in an 
earlier execution) 

2. If the Key Mapping uses ‘Selected Key Mappings’ no match will be 
found unless all target values match the translated source values. 
Note that the source field value is not mapped directly, it is the value 
derived from the source mapping that is used.  

Set Default: The Default value is used to set the target field 
instead.

No Match Action Description
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Example: If you use a value mapping for the status field [New-
>Assigned] as the key mapping, the target entry with value ‘Assigned’ 
will match with the source entry ‘New’. 

3. Inclusion of reference field mappings in key mappings is not 
recommended. 

4. In most cases, a reference mapping using a Key Mapping defined with 
'Selected Key Mappings' will be able to map a source id even if the 
source record itself was not migrated previously in execution by 
looking up the source data values and generating an appropriate query 
to look up the target id. However this will NOT be the case when either 
of the following applies: 

1. The selected key mappings reference a temporary field value in 
an assignment expression. 

2. The selected key mappings include a lookup mapping. 

In this case, if the source id being mapped was NOT migrated earlier 
in the execution of this project then no attempt will be made to identify 
a target id and the 'No Match' action will be applied. 

Creating a new Lookup Field Mapping 

Lookup Field Mappings should be used whenever the field value that you 
want to migrate is not on the Source Form.  The Lookup Query is used to 
select a value from a different form either on the Source or Target server. 

To create a new Lookup Mapping, first select the Target Field from the list of 
fields in the Field Mapping List, then select Lookup from the New Mapping 
field below.  A new screen is then presented to allow the Lookup Mapping to 
be completed: 

!  
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Important Note: Before you can create a new Lookup Mapping you must first 
create a Lookup Query using the Lookup Queries tab on the Form Mapping.  
For more information on creating Lookup Queries, see Chapter 17. 

First select the Lookup Query Identifier using the drop-down menu, then 
select the Lookup Field from the corresponding drop-down menu (based on 
the Lookup Query Form).   After selecting the Lookup Query Identifier, the 
details of the Query are displayed underneath in read-only format. 

If no matching records are returned by the Lookup Query then you can define 
what action to take using the No Match Action field: 

In some cases, more than record is returned by the Lookup Query.  In this 
case, you can use the Multiple Match Action field to control the behaviour of 
the migration as follows: 

On No Match Action Description

Set Null Sets the target field value to Null;

Skip Record No target values are set for this record, skips 
to the next record;

Log Error No target value is set but an error is recorded 
in the log.

Set Default The Default value is used to set the target field 
instead.

Multiple Match Action Description

Set Null Sets the target field value to Null;

Use First Sets the target value to the field value returned 
by the first record in the Query.

Skip Record No target values are set for this record, skips 
to the next record;

Log Error No target value is set but an error is recorded 
in the log.

Set Default The Default value is used to set the target field 
instead.

Concatenate CSV Sets the target field to a list of comma 
separated values based on the matched 
records retrieved from the lookup.



Copyright Service Management Integrations Limited. 2015-2018.                    
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/
or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. 
BMC and Remedy are registered trademarks of BMC Software Inc.  SQL Server and 
associated logo are trademarks of Microsoft.  Oracle and Java are registered trademarks of 
Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Document Version: 
3.10.2 

Date: Oct 2018 
Page !  52

ITSM Bridge Product User Guide                 !  
——————————————————————————

If you choose Set Default, then enter the Default value in the Default field 
next to the above options. 

Note that Concatenate CSV delimits all values in the list with double quotes, 
even if only one value is returned. 

Now use the Validate button to validate the Lookup mapping details.  Then 
use the Apply button to save your changes, or use the Revert button to 
revert back to the last saved version. 

Creating a new ID List Mapping 

ID List Mappings can be used for ServiceNow to ServiceNow migrations 
when the target field type is a ServiceNow List field.  The source value can 
either be another ServiceNow List field, a String field or a temporary variable 
(of type string). 

To create a new ID List Mapping, first select the Target Field from the list of 
fields in the Field Mapping List, then select ID List from the New Mapping 
field below.  A new screen is then presented to allow the ID List Mapping to 
be completed: 

!  

The Source Type can be either Source Field or Temporary Variable.  If 
Source Field is selected then a drop-down list of source fields is provided for 
selection.  The source field selected should be either a ServiceNow List field 
or a String field.   

If Temporary Variable is selected, the variable must be set either from 
another List type field or populated with a comma delimited set of sys_id 
values (without any value delimiters).  For example, use a lookup mapping 
with the concatenated values option to obtain a list of sys_id values, then 
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strip out the quotes (with an assignment mapping) to leave a list of sys_id's 
which could then be mapped to the list field. 

In ServiceNow, the List field contains a list of SysIDs, each of which relate to 
records in a reference table.  During execution, the target server is searched 
for the corresponding list of SysIDs based on the display value of the field.  If 
you want to use something other than the Display Value to identify the list, 
change the option from Use Display Field Values to Use Selected Field 
Mappings.  When you select this option, a new tab called Reference Field 
Mappings is displayed like this: 

!  

This allows the user to enter one or more source and target values that can 
be used to uniquely identify the target records on the referenced table. 

If no matching record is found you can control the behaviour using the No 
Match Action field on the Source Tab as follows: 

On No Match Action Description

Ignore Ignores the mapping and leaves the target 
unchanged.

Skip Record No target values are set for this record, skips 
to the next record;

Log Error No target value is set but an error is recorded 
in the log.

Warning No target value is set but a warning is 
recorded in the log.
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Similarly if multiple matches are found, you can control the behaviour using 
the Multiple Match Action field as follows: 

Creating ID List Field Mappings using String Fields or Temporary 
Variables 

If the Source Type is Source Field and the source field selected is a String  
then the Reference Forms tab should be used to identify which table the ID 
values in the source list reference so that their display values can be looked 
up. 

!  

Similarly, if the Source Type is Temporary Variable, the Source Reference 
Form must be selected to identify which table the ID values in the temporary 
variable reference. 

If the target field is of type String or the target is a temporary variable then the 
Target Reference Form must be selected to identify which table the ID 
values on the target or temporary field relate to. 

Multiple Match Action Description

Use First Sets the target value to the field value returned 
by the first record in the Query.

Skip Record No target values are set for this record, skips 
to the next record;

Log Error No target value is set but an error is recorded 
in the log.

Warning No target value is set but a warning is 
recorded in the log..
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Creating a new ID Replacement Mapping 

ID Replacement Mappings can be used for ServiceNow to ServiceNow 
migrations when the source value contains one or more references to records 
in other tables using the SysID.  During execution, ITSM Bridge searches the 
target instance for the corresponding records and replaces the SysID values 
with the corresponding SySIDs on the target so that the expression remains 
valid. 

For example the source string could be an encoded query expression like 
this: 

assignment_group=1fcde0abdba1d3005b32f2f5ab961902^state=2^assigned
_to=56826bf03710200044e0bfc8bcbe5dca^EQ

Here the ID values represent a group, state and user on the source instance.  
The ID Replacement mapping will convert these to the corresponding IDs on 
the target instance. 

The source field can be 
 a) a single SysID value 
 b) a list of SySid values or 
 c) a conditional expression that includes one or more SysID values. 

The source value can either be another ServiceNow field or a temporary 
variable of type string. 

!  

If you specify the Source Type to be ‘Source Field’, then you must select the 
source field from the drop down list.  Similarly if you specify the Source Type 
to be Temporary Variable, you must select the variable name from the drop-
down list. 

When searching for the corresponding values on the target instance, you can 
control the behaviour when no match is found by specifying the No Match 
Action.  This can be set to either ‘Use Source’ (replace with the source 
value), ‘Set Null’, ‘Skip Record’ or ‘Log Error’.    
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Similarly if multiple matches are found, you can control the behaviour by 
specifying the Multiple Match Action. This can be set to ‘Use Source’, ‘Use 
First’ (use the first record returned), ‘Set Null’, ‘Skip Record’ or ‘Log Error’. 

Next, you need to specify whether to include a single/List of ID values or to 
include ID’s from and encoded query string expression or both. 

If you specify a Single/List of ID values then you must also provide the name 
of the source and target reference tables that the ID value(s) relate to using 
the Single and List Replacement tab: 

!  

If you specify, ‘Include IDs from Encoded Query Strings’ then you must also 
specify the source and target tables from which the fields in the query string 
originate using the Encoded Query Replacement tab: 

!  

In this case, you can either select the table names explicitly from the drop-
down lists or select ‘Source Table from Field Mapping’ and select the field 
mapping that holds the name of the referenced table in each case. 

Notes on use of the ID Replacement mapping 

1. When replacing sysIds using this field mapping, the sysIDs are matched 
using the field display values. If two records on the target have the same 
display value, the multi-match option is applied. 
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2. For Multi-Match or No-Match options the 'Use Source', 'Set NULL' or 'Use 
First' selections will generate a warning for the target record which can be 
viewed in the migration report, if configured. 

3. The ID Replacement mapping cannot currently convert expressions that 
include ‘dot-walking’ references to other tables. For example: 

  
assignment_group=1fcde0abdba1d3005b32f2f5ab961902^state=2^assigned
_to=56826bf03710200044e0bfc8bcbe5dca^closed_by.cost_center=5bc4b4
c2db775300a03460535b961976^EQ 

In this case, the source field closed_by.cost_center will not be recognized as 
it is not on the current table, leading to its value remaining unchanged in the 
transformed string. In this case, a warning would be shown in the migration 
report.

Generating Default Mappings 

This feature allows you to automatically map all fields between the source 
and target forms based on matching field names or field ids.   To use this 
feature, first open the Form Mapping from the Mapping List, then click on 
the Generate Default Mappings button at the bottom right of the Field List 
table. 

!  

After clicking on this button, a new pop-up window is displayed with the 
following auto-generate options: 

1. Match By Field ID or Field Name 

If Field ID is selected, all fields on the Source form are automatically mapped 
to fields on the Target form with the same Field ID.   If Field Name is 
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selected, all fields on the source form are automatically mapped to fields on 
the Target form with the same Field Name. 

If no matching field id/field name is found then the field is not mapped. 

2. Overwrite Existing Mappings 

If this option is selected then any existing mappings will be overwritten with 
the new mapped value. 

3. Include System Populated Fields 

If this option is selected then System fields on the Target form that are 
normally set by the application are also mapped to the corresponding fields 
on the Source form, (e.g. ‘Last Modified By’ field in Remedy applications). 

!  

Click on OK to start the automatic field mapping generation or Cancel to 
cancel the operation. 

All fields that meet the specified criteria are mapped using the Simple 
Mapping Type (see above). 

Updating an Existing Field Mapping 

To update an existing Field Mapping, simply select the row in the Field 
Mappings List, update the values in the window below and click on the 
Apply button.  Note that the format of the window presented below will 
depend on the field mapping type (Simple, Assignment, Value Match, 
Reference, Lookup or ID List). 
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Handling Invalid Field Mappings 

After opening a form mapping for an existing project, if any of the mapped 
fields map to a target field that doesn't exist, a warning will be presented 
providing the option to remove the corresponding mapping:   

!  

Selecting Yes, removes all invalid field mappings.  Selecting No, opens the 
form mapping and presents the invalid field mappings in red at the top of the 
field list like this: 

!  
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To clear the invalid field mapping(s), select the field(s), then click on the Clear 
Selected button. 

Creating temporary variables 

Temporary variables can be used to store values that you want to use in a 
field mapping expression.  These are typically used when a field mapping 
assignment cannot be performed in a single step.   

To create a temporary variable, click on the variables button at the bottom on 
the field mapping list. 
 

The following pop-up screen is then displayed allowing you to create one or 
more variables of type boolean, currency, date, decimal, integer, timestamp, 
time or string: 

!  

Once temporary variables have been defined they will appear in green at the 
top of the field mapping list like this: 
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!  

To set the value of a temporary variable, use any of these field mapping types 
described above, (Simple, Assignment, Lookup, Value Match, Reference or 
ID List).  Once the variable mapping has been defined, it will appear in the 
field mapping list like this: 

!  

Using temporary variables in expressions 

Once a temporary variable had been defined, it can then be used in a lookup 
or assignment expression, or in a Value Mapping. For example it could be 
used to set the value of a field on the target table using an assignment 
mapping expression like this: 

SUBSTRING(#!Change Manager Email!#,0,STRPOS(#!Change Manager 
Email!#,'@')) 

Note that the temporary variable is automatically enclosed with #! and !# 
delimiters. 

Temporary variables can also be used in lookup queries like this: 
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!  

The lookup query can then be used to set another field on the target table. 
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15. Defining Key Mappings 

Key Mappings are an attribute of a Form Mapping.  They are used to define 
which fields are primary keys on source and target forms.  Primary keys are 
important because they can be used to affect the behaviour of the migration; 
In particular whether a new record is created on the Target Form or whether 
an existing record is updated. 

To view the Key Mappings for a Form Mapping click on the Key Mapping tab 
on the Form Mapping screen. 

!  
  

If a key mapping has already been defined for this Form Mapping, it will be 
displayed here.  If not the default (No Key Mappings) will be set. 

There are four different types of Key Mappings that can be defined and the 
behaviour of each type is summarised in the table below. 

Please note that for ServiceNow -> ServiceNow migrations, the Migration 
Method ‘Import Set (Scripted)’ with the Migrate SysID’s option always 
takes precedence over any Key Mappings that you define here.  See the 
Migration Method in Execution Options for more information on this.
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Key Mapping Option Behaviour

No Key Mappings If the Execution Migration Method is ‘Import Set (Scripted)’, 
the option to migrate SysIDs is selected and a target record 
exists withe the same Sys ID as the source record, the 
migration will UPDATE this target record.   Otherwise a new 
record is INSERTED.

Use Server Defined 
Record ID fields

If the Execution Migration Method is ‘Import Set (Scripted)’, 
the option to migrate SysIDs is selected and a target record 
exists withe the same Sys ID as the source record, the 
migration will UPDATE this target record.   Otherwise the 
following will apply: 

On the FIRST execution of the migration, ALL source records 
will be INSERTED (no updates are performed). 

ITSM Bridge will keep a record of the source to target ID 
mapping and on subsequent executions will check these 
records to identify which target record (if any) was previously 
generated from the source record. If a target record is identified, 
this record is UPDATED. 

If the above does not apply then a new record is INSERTED. 

Note: Field Reference Mappings that use this ID Mapping will 
only be able to return a value for target records that have 
already been migrated. 

Warning: Migrating records to the same target server using 
a different project will NOT be able to map to the target 
records created by the first project using this method.

Select Key Mappings 
(maximum of 5)

If the Execution Migration Method is ‘Import Set (Scripted)’, 
the option to migrate SysIDs is selected and a target record 
exists withe the same Sys ID as the source record, the 
migration will UPDATE this target record.   Otherwise the 
following will apply: 

The set of defined Key Mappings are used to identify a target 
record.  If a target record with the same key mapping is found, it 
will be UPDATED. 

If more than one target record matches, the multiple-match 
option is applied. 

If none of the above applies then a new record is INSERTED. 

Warning: If the target key values are changed during the 
execution of the project, the target record may not be mapped 
correctly which can result in duplicate records being created or 
execution time failures.
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For migrations from BMC Remedy servers, if the option ‘Use Server Defined 
Record ID Fields’ is selected, the user has the option to define both a 
Primary and Secondary Source ID Field.  The Primary Source ID field is 
the unique field that determines whether the migration is an update or create 
operation and should therefore remain unchanged between migrations. 

If the Primary Source ID is set to the Request ID, the user may optionally 
select the InstanceID as a secondary ID field. 

If the Primary Source ID is set to InstanceID, the secondary ID will 
automatically be set to the Request ID.   No other values are permitted for 
these fields. 

The Target ID Field is set to the sys_id field on ServiceNow servers and 
cannot be changed. 

Use ID Mappings 
derived in Earlier Form 
Mapping

If the Execution Migration Method is ‘Import Set (Scripted)’, 
the option to migrate SysIDs is selected and a target record 
exists withe the same Sys ID as the source record, the 
migration will UPDATE this target record.   Otherwise the 
following will apply: 

The ID mappings derived during the execution of an earlier form 
mapping will be used to identify a target record. If the source 
record was migrated in the earlier form mapping then the same 
target record will be UPDATED. 

If the source record was not migrated previously then the No-
Match option will apply. 

If the original form mapping is disabled then the No-Match 
action will apply to all migrated records.

Key Mapping Option Behaviour
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!  

Both the Primary and Secondary Source ID fields can be used in reference-
type field mappings (see above) for Form Mappings that execute after the 
current mapping (i.e. with a higher execution order). 

If the option ‘Select Key Mappings’ is selected, the following screen is 
displayed to allow the selection of up to 5 key fields: 

!  

Use the menu to select from the list of mapped target fields for this form 
mapping, then click on the Add button to add the field to the key mapping 
table.  Both the target field and the source field from the mapping are 
displayed in the table. 
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Note that the mapping is not restricted to simple mappings. As long as the 
value derived from the mapping matches the current value on the target, the 
mapping will operate correctly. So you can have assignment, value or 
reference type mappings selected as key mappings. 

If you make a mistake, you can remove a key field from the mapping table by 
selecting the corresponding row and clicking on the Remove button. 

If the option Use ID Mappings Derived in Earlier Form Mapping is 
selected, you must select the previous mapping and the No-Match action.  
The No-Match action is applied if no corresponding record is found on the 
target based on the previous mapping or the previous mapping is disabled.  
The No-Match action options are ‘Create New Record’, ‘Skip Record’ or ‘Log 
Error’. 

 !  

Controlling Multiple-Match Behaviour 

Once you have selected your key mapping fields, you can also control the 
behaviour of the migration when multiple records are found on the target 
server for the specified key. 

Depending on the option selected, if multiple target records are identified that 
match the specified key during execution, then either the first record found is 
updated, the record is skipped or an error is logged.  By default, the ‘Use 
First’ option is selected for each Form Mapping. 

Additional Key Mapping Options 

When defining a key mapping you also have the following options: 
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When migrating to a ServiceNow server building the cache when the number 
of records being migrated is > 5% of the number of existing target records is 
likely to improve overall performance. 

When migrating to a BMC Remedy server, building the cache when the 
number of records being migrated is > 2% of the number of existing target 
records is likely to improve overall performance. 

If a there are large number of reference lookups, that obtain data outside the 
set of records being migrated, building a cache may also improve 
performance. Building a cache can however use significant memory 
resources on your client desktop, which needs to be considered when 
deciding whether to build the cache or not. 

Notes on use of Key Mappings 

Warning: Changes to the values of source/target fields used in key mappings 
externally (between executions) can lead to the mapping of the records being 
‘broken’. Therefore it is important to choose key fields on the source and 
target server and are unlikely to change. If changes are made externally to 
these key fields, ensure they are made on both the source and target record. 

Example: 
• Use Company name field [simple mapping] as the key field 
• Execute the project, source company ‘ACME’ maps to target company 

‘ACME’, which gets updated 
• Change the target company name to ‘ACME Ltd’ 
• Subsequent execution will create a new company record ‘ACME’ 

The recommended best practice approach is therefore: 

Option Meaning

Build Target Key Cache Before 
Use

Builds and stores a target key for each 
existing target record before migration. 
This allows the source entries to be 
mapped to a target without the need to 
'look up' the target key individually.

Allow NULL values in key fields If unchecked, a null in a key value will lead 
to an error and the entry not being 
migrated. For reference mappings, if the 
mapping uses a key with a NULL, the NO 
Match procedure is followed
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ALWAYS use the Selected Key Mappings option if any set of mappings can 
be found in the source/target records where: 

1. Values are consistent (for all migrated records) on the source and 
target server 

2. Values represent a unique entry on the target server 
3. Values do not (generally) change over time on the source or target 

server 

Do not use the Server Defined Record ID’s option when: 
1. You want to update existing records that were not created in previous 

executions of this project 
2. You use the same project against several source/target servers 

For target fields used in key mappings, at least one of the fields should be 
indexed when there are more than 10,000 records in the table in order to 
improve performance and reduce the risk of timeout errors. 
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16. Restricting Source Records (Source Filtering) 

Source Filtering is an attribute of the Form Mapping and is used to restrict the 
number of records to be included in the migration.  For example, you may 
only want to migrate the records that relate to a particular company. 

Source Filtering allows you to restrict the records that are migrated either by 
constructing a query or by defining an Inclusion rule or both.  During 
execution, the query and/or Inclusion rule is evaluated and only the resulting 
set of records are included in the migration. 

Filtering Records Using a Query 

In order to define the Source Filtering Query, first navigate to the Source 
Filtering window by selecting the Source Filtering tab on the Form Mapping.  
Then click on the Query Builder button to create or edit the query. 

!  

The query can be constructed from a combination of Field values, Keywords, 
Variables and various operators. 

!  

To add a field from the Source Form, a keyword or a variable to the Query, 
select the value from the corresponding dropdown list,then click on the Add 
button next to the Field/Keyword/Variable.  

Note that fields must always be enclosed in square brackets and strings must 
always be enclosed in single quotes. 
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The following keywords are available: 

NULL: Converts to the NULL string during execution; 
DATE: Converts to the current date during execution;  
TIMESTAMP:  Converts to the current date and time during execution; 
TIME: Converts to the current time during execution; 

Variables can be used in the Query if the value of the operand is not known 
until the time of execution.  All variables must be created in advance before 
they can be selected and used in the Query, (see later section on defining 
variables). 

A summary of the operators available and their meaning is provided in the 
table below: 

Operator Description

AND Logical AND operator to be used with two 
expressions within the Query: {Expr 1} AND {Expr 2}

OR Logical OR operator to be used with two 
expressions within the Query: {Expr 1} OR {Expr 2}

NOT Logical NOT operator to be used with one 
expression within the Query: NOT {Expr}

() Brackets used to group a logical set of expressions 
together within the Query.

= Logical Equivalence between two expressions in the 
Query:  {Expr 1} = {Expr 2}.  Note {Expr 1} or {Expr 
2} may just be field values or literals in this case.

!= Logical Unequal comparison of two expressions in 
the Query: {Expr 1} != {Expr 2}

>, >= Logical ‘Greater than’ / ‘Greater than or Equal to’ 
comparison of two integer values or date values in 
the Query.

<, <= Logical ‘Less than’ / ‘Less than or Equal to’ 
comparison of two integer values or date values in 
the Query.
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When you have finished entering your query, click OK to validate the query 
and close the Query Builder window. If you update the query without using 
the Query Builder, you can use the Validate button on the bottom right to 
validate the syntax  If ok, a message will be displayed to indicate that the 
query is valid.  If not it will indicate that there is an error in the query that 
needs to be corrected before it can be saved. 

Once your query has been validated, use the Apply button on the bottom 
right to apply and save the query. 

Some example queries are provided below for reference: 

Example 1: 

[Last Modified Date] > (TIMESTAMP - (((60 * 60) * 24) * 30)) 

Restricts selection to those records modified within the last 30 days. 

Example 2: 

LIKE Used for partial match of a string.  e.g. [Surname] 
LIKE (‘Park’ + ‘%’)  would match all surnames 
beginning ‘Park’.

Str Used to generate two single quotes in the Query to 
enclose a string value.

+ Used to add two strings together OR to add two 
integers, decimals or real numbers together OR to 
add an offset (in days) to a date value OR add an 
offset (in seconds) to a date-time or time value.

- Used to subtract one integer/decimal/real value from 
another OR to subtract an offset (in days) from a 
date value OR to subtract an offset (in seconds) 
from a date-time or time value.

* Used to multiply two integer/decimal/real values 
together

\ Used to divide one integer/decimal/real value by 
another

MOD Used to calculate the remainder when one integer is 
divided by another.

Operator Description
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([Last Modified By] != 'Demo') AND ([Status] = #Status#) 

Restricts selection to those records that were not modified by Demo and 
whose status matches the variable called status (value provided at 
execution). 

Using the Source Count button 

The source count button can be used at any time to count the number of 
records on the source form/table based on the current Source Filter Query. 

If no variables are used in the query then the record count is immediately 
displayed in a pop-up window when the Source Count button is clicked. 

If one or more variables are used in the query, then a pop-up window is 
displayed like this: 
 

Enter a value for each variable then click on the Update Count button to 
count the number of records on the source form/table based on the query 
defined and the values provided for each variable.   Variables can also be set 
to NULL using the Set NULL button. 

Whenever the variable values are changed, the user is prompted with the 
option to save these values as defaults for the next migration execution. 

Usage of Source Filtering Query when Source Server Type is 
ServiceNow 

When the source server type is ServiceNow, the following restrictions apply: 

a) For a Relational Operation, the Left Hand Side of the expression must be 
a field or a project variable, e.g: 

1. [Name] = ‘Tom’ 
2. [company] = #Company Name# 
3. #Single Company# = TRUE 
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4. ([company] = #Company Name# AND #Single Company# = TRUE) 
OR #Single Company# = FALSE 

The value can be either a fixed value, project variable or another field of the 
same type. 

b) All arithmetic operations (+ - * / MOD) are supported for numeric values.   
The ‘+’ operator can also be used for string concatenation. 

c) If a query contains a string value for a field which has choices (e.g. State 
field on HR Case), the choice label value will be replaced with the 
underlying value when the query is run. This should be the case for both 
string and integer fields. If no underlying value can be found for the choice 
label given, the choice label will be used in the query (usually resulting in 
no entries being returned)   e.g. [State]='Draft' will run as [State]=1 

d) If a query contains a display value for a reference field, the value will be 
replaced with the corresponding sys id before the query is run. Again if no 
matching record is found, the display value is used, generally resulting in 
no match.  e.g. [assigned_to]='Abel Tuter' will run as 
[assigned_to]=<sysid of Abel Tuter user entry> 

e) Conditions c) and d) above also hold true when using variables. The 
variable used should be defined as a STRING, even if the field being 
compared to is actually a non string field.  e.g. [state]=#STATE#, where 
#STATE# is a string variable with value 'Ready' will run as [State]=10 

f) Date/Time arithmetic is NOT supported. The additional parameterised 
keywords are available for this purpose. 

g) Only variables and literal values can be used in arithmetical operations. 
Field references cannot be used. 

h) LIKE operator. This is supported in a limited way (due to limitations in 
ServiceNow): 

i) Only the '%' (match zero or more characters) wildcard is supported. 
ii) Field references cannot be used in place of a value. 
iii) The wildcard must be either at the start and/or end of the string. e.g. 
'Bob % Backline'  is not a valid search pattern but '%Bob%', 
 '%Backline' and 'Bob%' are all valid. 
iv) The use of a variable to define a search string is not supported, 
however arithmetic operations can be used to build a pattern string. e.g. 
[Name] LIKE '%'+#searchName# +'%' is valid. 
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When using a project variable as the left hand side of a relational operation 
such as <Variable><op><Value>, the following additional restrictions apply: 

<Variable> must be a valid project variable 
<Value> can be either a constant value, keyword or another variable.  
<Value> CANNOT be an arithmetical expression. The type should be 
consistent to that of the variable. 
<op> must be any relational operator that is relevant to the data type. LIKE is 
also supported for string comparison (case insensitive) 

For example the following are supported: 

 • #Boolean#=TRUE 
 • #Boolean 1#!=#Boolean 2# 
 • #DATE TIME#>TIMESTAMP 
 • #Company Name# LIKE '%bridge%' 

There can be multiple clauses of this type in a single query. 

Note that this does NOT apply to lookups. If an attempt is made to add such a 
clause in a lookup it will result in a design time error. 

Filtering By Inclusion 

In some situations in may be desirable to filter the records by associating 
them with another set of records, either from a previous form migration in the 
same project or by using an Ad-Hoc Query.  For example, when migrating the 
work-logs for an Incident, you may only want to migrate those work-log 
records for which the corresponding parent Incident records are migrated. 

To filter in this way, navigate to the Filter By Inclusion section on the Source 
Filtering Tab and select ‘From Previous Migration Set’ for the Value Set 
Definition Method.  Using the above example, if the current (child) form 
mapping is for Work-logs, then you must have defined a form mapping for 
Incident (parent) with a lower execution order. 
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The fields in this section are defined as follows: 

In the above example, the Source Field on the Work Log (child) form is the 
Incident Number (this is what relates the Work Log to the Incident), the Value 
Set Migration Mapping is the HPD:Help Desk and the Value Set Source Field 
is the Incident Number (on the parent Incident). 

When the project is executed, only those work-logs which belong to Incidents 
that have been migrated are themselves migrated. 

Filtering By Inclusion Using an Ad-Hoc Query 

This method of filtering is useful if there is no previous migration set to relate 
to but you still want to restrict the records by relating them to another set of 
data. 

To use this method, navigate to the Filter By Inclusion section on the 
Source Filtering Tab and select ‘From Ad-Hoc Query Set’ from the Value 
Set Definition Method. 
 

Field Name Meaning

Source Field The name of the source field on the current 
form mapping that is used to match a value in 
the Value Set (parent) mapping.

NULL Value Action If set to Include, will ALWAYS include child 
records for which the source field is NULL 
(even if there are no NULL values in the value 
set) 
If set to Exclude will ALWAYS exclude child 
records with a NULL source field value.

Value Set Migration Mapping The name of the previous form mapping which 
represents the Value Set (parent).

Value Set Source Field The field on the Value Set to be matched with 
the source field on the current mapping
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In this case, instead of selecting a previous migration, select a Value Set 
Form instead using the Value Set Form field.  This allows you to select any 
form from the Source server.   Then construct a query using the Query 
Builder to define the set of records that the Value Set (parent) is restricted to. 

In the example above, only those work-log records are migrated for which the 
related Incident has a Modified Date greater than the variable cutoff date and 
are not closed.  As with the previous example, the Work-log records are 
related to the Incident (HPD:Help Desk form) using the Incident Number field 
on each. 

Use the Validate button to validate the Ad-Hoc Query and the Apply button 
to save. 
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17. Defining Lookup Queries 

Lookup Queries can be used to select field values from any form or table on 
the source or target server which can then be used as input to your Form 
Mapping definition.  These can be used whenever the value that you want 
migrate does not reside on the Source Form that you have selected.   

Lookup Queries are an attribute of a Form Mapping and you can define as 
many queries as you need for any given mapping. 

To create a new Lookup Query, open the Form Mapping from the Mappings 
List, then navigate to the Lookup Queries tab. 

!  

This window is divided into two sections: the top section lists all the existing 
queries for this Form Mapping, the bottom section is used to create new 
Lookup Queries.  When you first navigate to the Lookup Queries tab the top 
section will be empty. 

Defining Source Lookup Queries 

To create a new Source Lookup Query, select the Type (Source) and the 
Search Form from the drop-down list.  The Identifier field is auto-populated 
but you can change the value if necessary.  The identifier is used to uniquely 
identify the Lookup Query that you have defined. 

Now click on the Query Builder button to define your Lookup Query.  Note 
that we are not defining which field value to return here, just the query itself. 
You can use the same query to select different fields for different field 
mappings. These are selected as part of the Field Mapping Definition. 
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!  

The Source Lookup Query window is shown above. 

Select the field from the Search Form Field menu then enter a condition 
using any of the operators below (AND, OR, NOT, (, ). =. != etc.), in 
combination with a keyword value (NULL, DATE, TIMESTAMP or TIME) 
and/or the Current Entry Value from the Form Mapping Source Form or a 
Temporary Variable. 

In the example above, the Site ID is used to identify a record on the SIT:Site 
Company Association Form based on the Site ID value on the current Form 
Mapping Source Form.  So for example, if the current Form Mapping Source 
Form is SIT:Site, then we can supplement the values used in this mapping 
with values from the SIT:Site Company Association form, using this Lookup 
Query. 

For more information on defining and using temporary variables, see previous 
section on Defining Field Mappings 

Defining Target Lookup Queries 

To create a new Target Lookup Query, navigate to the Lookup Queries tab 
click on New Query, then select the Type (Target) and the Search Form from 
the drop-down list.  The options for Target Lookup Queries are slightly 
different.  The value that you compare with can either be on the source or 
target server.   To compare with a value on the target server, select the field 
from the Current Entry Value (Target) field.  e.g. 
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!  

To compare with a value on the source server click the checkbox ‘Use 
Current Source Values’.  In this case, the Current Entry Value field changes 
to  ‘Current Entry Value [Source]’ and the field value that you select is pre-
fixed with ‘SRC.’ to indicate that it relates to a source field value.  e.g. 

!  

In this example the field on the target server is compared with the current 
value of the Company field on the source server.  The source and target 
servers can either be of the same type (e.g. ServiceNow), or different types, 
(e.g. ServiceNow and Remedy). 
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You can also use temporary variables in the expression by selecting from 
Temporary Variable dropdown.  Note that the temporary variable must have 
been defined previously before it can be used in an expression.  For more 
information on how to create temporary variables, see previous section on 
Defining Field Mappings. 

Note that you cannot mix the use of source and target values in the same 
query expression.  So for example the query  

[Company] = #SRC.Company# and [Company ID] = #Company ID#  

would not be allowed because it references values from both source and 
target servers. 

After you have finished entering your query, click the OK button to save it. 

You can then use the Validate button to the right of the screen to check that 
the query entered is valid.  Then click on the Apply button to save the Query 
or click on the Revert button to revert to the last saved version.  After 
applying the Query, it will appear in the list of Lookup Queries in the top 
section like this: 

!  

To create another Lookup Query for this Form Mapping, use the New Query 
button, or to remove an existing Lookup Query from the list, use the Remove 
button. 

Warning: If you remove a Lookup Query after it has been referenced in a 
Field Mapping then the Field Mapping will become invalid and must be 
corrected prior to migration.  A message to this effect will be displayed in this 
case. 
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To modify an existing Lookup Query, simply click on the corresponding row in 
the list of Lookup Queries, make the necessary changes using the fields in 
the bottom section (including Query Builder if required), the click on the Apply 
button to save your changes. 

Usage of Lookup Queries when Target Server Type is ServiceNow 

If you select the Target Type option, then the Query Builder options are a 
little different when the Target server is ServiceNow.  The Keywords 
available in this case are described in the table below: 

!  
Example Target Lookup Query 

The arithmetic functions, +, -, * and / as well as the logical operators NOT and 
LIKE are not allowed in this case (they can only be used with Remedy 
servers). 
Keyword Meaning

MINUTESAGO(INTEGER) Used for comparison with date-time fields. e.g. 
[date-time field] < MINUTESAGO(30) would return 
all records where the date-time field was more than 
30 minutes earlier than the current time.

HOURSAGO(INTEGER) Used for comparison with date-time fields. e.g. 
[date-time field] < HOURSAGO(12) would return all 
records where the date-time field was more than 
12 hours earlier than the current time.

TRUE Logical TRUE condition for comparison with 
boolean fields.

FALSE Logical FALSE condition for comparison with 
boolean fields.

YEARSAGO(INTEGER) Used for comparison with date fields. e.g. [date 
field] < YEARSAGO(5) would return all records 
where the date field was more than 5 years earlier 
than the current date.
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In this case, the Lookup Query Current Entry Value is based on the target 
result set, (i.e. the value the target field will have once it has been updated).  
For this reason, only target fields that have been mapped may be used in the 
query. 

Usage of Lookup Queries when Source Server Type is ServiceNow 

When the Source Server Type is ServiceNow, the same restrictions apply as 
for Source Filtering (see previous section). 

Also when both source and target servers are ServiceNow, when you 
compare a string value with a reference field, then the reference field is 
converted to the equivalent string value before the query is evaluated.  e.g. 

  [Title] = #src.category# 

where src.category is a reference field, would convert the category reference 
to the equivalent string value before the query is evaluated. 

Usage of Lookup Queries when Source or Target Server Type is 
ServiceNow 

For hard coded values only (not current entry values), both choice 
label reference field display values will be converted to their actual values. 

  e.g.  [Company] = ‘ACME’ would convert to [Company] = <SysID for 
company ACME>  

MONTHSAGO(INTEGER) Used for comparison with date fields. e.g. [date 
field] < MONTHSAGO(6) would return all records 
where the date field was more than 6 months 
earlier than the current date.

NULL Logical NULL condition 

DATE Equates to the current DATE

TIMESTAMP Equates to the current TIME

DAYSAGO(INTEGER) Used for comparison with date fields. e.g. [date 
field] < DAYSAGO(7) would return all records 
where the date field was more than 7 days earlier 
than the current date.

Keyword Meaning
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Optimising Lookup Queries for best performance 

When your lookup query (source or target) is searching a table with more 
than 10,000 records then it is highly recommended that at least one of the 
fields in the query is indexed in order to improve performance and reduce the 
risk of timeouts occurring. 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18. Defining Record Delete Conditions 

Note: this option is only currently available for Remedy source and target 
servers. 

In some situations, it may be desirable to delete records from the target 
server as part of the migration. Typically this is required when records have 
been deleted from the source server and are therefore no longer required on 
the target. 

Record Deletions are an attribute of a Form Mapping.  To define record 
deletion conditions, open the Form Mapping from the Mappings List, then 
navigate to the Deletions tab. 

!  

The first set of options on this screen specify the Delete Method, the 
Deletion Timing and the Deletion Exclusions.  A summary of the meanings 
for each option is provided in the tables below: 

By default, no records are deleted and the Delete Method for all mappings is 
therefore set to No Deletions. 

Delete Method Description

No Deletions No records are deleted under any 
conditions.

Delete All Target Records Identified By the 
Target Scope Query

Deletes all records based on the Query 
provided in the Target Scope Query below.

Delete Unmatched Records Deletes all records for which no match can 
be found on the source server using the 
matching criteria specified below.
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Note: The Exclusion Options only apply if the Deletion Timing is set to Delete 
After Migration. 

Deleting Records based on Target Scope Query 

If the Target Scope Query Delete method is selected, then you must enter a 
valid query in the Target Scope Query box.  Click on the Query Builder 
button to launch the Query Builder dialog window for constructing your 
query. 

!  

WARNING: All records that meet the criteria specified by this query will 
be deleted from the target server unless they have been specifically 
excluded using the options above. 

Deletion Timing Description

Delete Before Migration All record deletions are scheduled to take 
place before data migration.  In this case the 
exclusion options below do not apply.

Delete After Migration (Default Option) All record deletions are scheduled to take 
place after data migration. 

Exclusion Option Description

No Exclusions Does not exclude any records from the list of 
records identified for deletion.

Never Delete Migrated Records Excludes migrated records (for the current 
migration project) from the list of records 
identified for deletion.

Never Delete Migrated Records or Failed 
Updates

Excludes both migrated records and records 
that failed to update (for the current 
migration project) from the list of records 
identified for deletion.
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Before any records are deleted, a list of those records identified for deletion 
will be displayed.  You can configure which fields to display in this list using 
the tab called Deletion Selection Display Fields. 

When you click on this tab a separate table is displayed which allows you to 
specify up to 5 fields that you want to display when confirming that a record 
should be deleted. 

To add a field to this list, simple select from the drop-down menu against the 
Target Field, then click on the Add button.  If you make a mistake, you can 
always remove a field from the list by highlighting that row and clicking on the 
Remove button. 

!  

Deleting Records based on Unmatched Records 

If you select the option to Delete Unmatched Records then you must enter 
the details of how to search for matches on the source server.  You can either 
choose to use the existing Key Mappings for this Form Mapping, or manually 
select the Defined fields used for matching from the drop-down list of 
mapped target fields. 

!  
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You can add up to 5 fields as the basis for the match search.  Use the Add 
button and Remove button to selectively add or remove fields from the 
match search. 

Once you have defined the fields to be used for the match search, you must 
then define the scope of the source records to search.  By default, all source 
records are searched. The following table summarises the three options 
available to control the scope of the records to search on the source server. 

  
WARNING: When using the Use Defined Query option, take care to 
ensure that the query is defined in such a way as to always find all 
source entries that need to be replicated on the target. If a source 
record cannot be found that matches a given target record, the target 
record will be deleted unless it has been excluded using one of the 
exclusion options above. 

!  

If you select the Use Defined Query option then you must define a query 
using the query builder.  Click on the Query Builder button to launch the 
Query Builder Dialog window and enter the required query. 

Search Option Description

All Source Records At execution time, all source records are then 
searched to see if they match each target.  In large 
data sets, this can take some time.  For 
performance reasons, it is better if possible, to 
define a subset of records to search.

Migration Source Records The same set of source records that were migrated 
will be used in the search for a match. In most 
situations, this is the best way to ensure that the 
match is found without needing to retrieve the 
entire source data set.

Use Defined Query Define a custom query that will be used to identify 
the set of source records that will be searched for a 
match.
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!  
Finally, once you have defined all the options for Record Deletions, click on 
the Validate button to validate the options selected, then click the Apply 
button to confirm your changes.  If necessary you can always use the Revert 
button to cancel all Record Deletion settings and start again. 

During execution, if one or more records are identified as candidates for 
deletion then they are displayed in a list like this: 

!  
Select the records that you want to delete (or use the Select All button to 
select all records), then click on Delete Checked Records to confirm 
deletion, or select Cancel Deletion to cancel. 

NOTE: Once selected, the Delete Checked Records operation cannot be 
undone.  All checked records will be permanently deleted from the 
Target server. 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19. Additional Form Mapping Options 

To define additional options for a given Form Mapping, navigate to the 
Options tab for the selected Form Mapping.   The following options are 
presented and explained in more detail in the table below: 

!  

Field Options Description

Enabled Checked; 
Unchecked

If checked the form mapping is migrated 
otherwise it is skipped during execution.

Business Hours 
Restriction

None; 
Migrate Out of Hours 
Only

If set to migrate out of hours only, then 
this form mapping will not be migrated 
during the specified business hours.  See 
later section on defining business hours.
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Entry Exists on 
Target Action

Define at Execution; 
Error & Continue; 
Skip Entry; 
Update Entry;

If Define at Execution is selected, the 
global execution options for this apply, 
(see section on Execution Options).  
Otherwise, the specified option for this 
form mapping takes precedence over the 
global setting.

No Entry Exists on 
Target Action

Define at Execution; 
Error & Continue; 
Skip Entry; 
Create New Entry;

If Define at Execution is selected, the 
global execution options for this apply, 
(see section on Execution Options).  
Otherwise, the specified option for this 
form mapping takes precedence over the 
global setting.

Migration Method 
(Remedy Target 
Servers)

Define at Execution; 
Set & Create 
Merge

If Define at Execution is selected, the 
global execution options for this apply, 
(see section on Execution Options).  
Otherwise, the specified option for this 
form mapping takes precedence over the 
global setting.  Only applies to target 
Remedy servers.

Migration Method 
(ServiceNow Target 
Servers)

Direct; 
Import Set (Field 
Mappings) 
Import Set (Scripted)

If Define at Execution is selected, the 
global execution options for this apply, 
otherwise specified option defined here 
takes precedence. 
Direct performs direct inserts/updates on 
the target tables; No import sets are used. 
Import Set (Field Mappings) uses import 
set with mapped fields to migrate the 
data; If this option is selected then the 
option to run business rules is also 
available; 
Import Set (Scripted) uses a transform 
map script to migrate the data. If this 
option is selected then the option to run 
business rules and the option to migrate 
Sys Ids are also available.  See additional 
note below.

Run Business 
Rules (ServiceNow 
Target Servers)

Define at Execution; 
Yes; 
No;

If Define at Execution is selected, the 
global execution options for this apply, 
otherwise specified option defined here 
takes precedence.  Only applies when 
migration method is Import Set (Field 
Mappings) or Import Set (Scripted).

Migrate Sys ID’s 
(ServiceNow 
source and target 
servers)

Define at Execution; 
Yes; 
No;

If Define at Execution is selected, the 
global execution options for this apply, 
otherwise specified option defined here 
takes precedence.  Only applies when the 
migration method is Import Set (Scripted).

Attachment 
Migration Option

No Attachments; 
Selected Attachments; 
All Attachments;

Only applies to ServiceNow target 
servers.  See separate chapter below on 
Migrating Attachments

Field Options Description
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You should provide a value for chunk size < 10,000 if the form mapping 
includes very large records, i.e. with a lot of very large fields or with a large 
number of file attachments. 

Important Note on use of Migration Method: Import Set (Scripted) 

Using this method ensures that the Sys ID of the source record is used on the 
inserted target record thereby maintaining relationships based on reference 
fields.  If a target record is found with a matching Sys ID, this target record is 
always UPDATED regardless of the Key Mapping settings. 

The Import Set (Scripted) method should be used if you want to set the 
Created By, Created On, Updated By, Updated On or Mod Count fields on the 
target record and have defined field mappings for any of these.  It should also 
be used if you want to update a field with NULL, i.e. clear its current value by 
using a field mapping with the NULL keyword. 

Migration Chunk 
Size

Numeric Value Defines the number of records that should 
be retrieved and migrated  from the 
source server before the next chunk is 
retrieved.  Leave this field blank to use 
the default global value defined at 
execution (see Execution Options section 
below)

Field Options Description
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20. Defining Project Variables 

Project Variables are an attribute of a migration project.  They are used in 
Source Filtering expressions (see section on Source Filtering above) where a 
value within the expression may change from one execution to the next.  
They are particularly useful when the same expression is used in multiple 
Source Filtering Queries within the same project. 

!  

Instead of hard-coding a value into the expression, using a project variable 
allows the user to simply define the value in one place prior to execution.  
That value is then substituted in all expressions where the variable is used. 

For example you might have a Source Filtering Query like this: 

[Submitter] = ‘Fred’ 

Instead you could use a project variable to achieve the same result like this: 

[Submitter] = #Submitter# 

where #Submitter# is the name of the variable.  
  
Then prior to execution you can define the value that you want #Submitter# to 
take and this value will be substituted in all expressions where #Submitter# is 
used. 

Before you can use a project variable in a Source Filtering expression, you 
must define that variable for the current project.  To define one or more 
project variables, simply select Variables from the Project menu or right click 
on the project name in the left pane and select Variables: 

Note that Project Variables are completely separate from Temporary 
Variables which are only used for field mappings.  For more information on 
temporary variables see the previous section on Defining Field Mappings.
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!  

The following screen is then presented showing the current list of variables 
that have been defined for this project. 

!  

To add a new variable, click on the New button on the right of the screen, 
then enter the variable name and type in the fields on the left and click on the 
Add button. 

Note that variables must have unique names and cannot have any spaces in 
the name.  Only alpha-numeric characters and underscores are allowed. The 
first character cannot be numeric. 

The variable type can be String, Integer, Double, Datetime, Date or Time. 
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To update an existing variable, select the corresponding row from the table, 
then change the variable name or type using the fields on the left, then click 
on the Update button. 

!  

To remove an existing variable, select the corresponding row from the table, 
then click on the Remove button on the right.  

Note that if a variable is currently referenced in an expression, it cannot be 
renamed or removed. 

Variable values can be set for each execution as part of the Execution 
Options (See next section). 
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21. Execution Options 

!  

When you are ready to execute your migration project, select Execute from 
the Project menu: 

!  

If you have not saved the project since you selected this Execute options 
then you will be prompted to do so. 

The configuration options are presented across five tabs: 

 Variable Values,  
 Migration Options,  
 Logging/Reporting,  
 Validation and  
 Advanced: 

Warning: It is recommended that the number of records migrated in any 
single execution run does not exceed 100,000.   If you have more than 
100,000 records in your source table, use the Source Filtering option on 
the corresponding mapping to define a query so that the total record count 
is reduced.  After execution, modify the query so that the next batch of 
records is selected.
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!  

Defining Variable Values 

To enter a value for a variable, select the corresponding row in the table, then 
enter the value directly into the Value column.  If you want to set the variable 
to NULL, click on the Set Null button.   To save the current settings without 
executing, use the Save Settings button. All variables must be defined 
before the execution can begin. 

Defining Migration Options 

On the second tab, you will see the following configuration options for the 
execution: 

!  

To save the current values without executing, use the Save Settings button. 

This table describes the options available for each field: 
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Field Options Description

Entry Exists on 
Target Action

Error & Continue; 
Skip Entry; 
Update Entry;

If a matching entry is found on the 
target form/table based on the key 
mapping defined for each form mapping 
then the corresponding action is taken.  
Note that the Form Mapping Options for 
this take precedence. 

No Entry Exists on 
Target Action

Error & Continue; 
Skip Entry; 
Create New Entry;

If no matching entry is found on the 
target form/table based on the key 
mapping defined for each form mapping 
then the corresponding action is taken.  
Note that the Form Mapping Options for 
this take precedence.

Migration Method 
(ServiceNow Target 
Servers)

Direct; 
Import Set (Field 
Mappings) 
Import Set (Scripted)

Direct performs direct inserts/updates 
on the target tables; No import sets are 
used. 
Import Set (Field Mappings) uses 
import set with mapped fields to migrate 
the data; If this option is selected then 
the option to run business rules is also 
available; 
Import Set (Scripted) uses a transform 
map script to migrate the data. If this 
option is selected then the option to run 
business rules and the option to migrate 
Sys Ids are also available. See 
additional options below.

Run Business Rules 
(ServiceNow Target 
Servers)

Yes; 
No;

Only applies when migration method is 
Import Set (Field Mappings) or Import 
Set (Scripted).

Migrate Sys ID’s 
(ServiceNow source 
and target servers)

Yes; 
No;

Only applies when the migration 
method is Import Set (Scripted). Sys ID 
value on source record is migrated to 
new target record.  If matching Sys ID is 
found on target table, the target record 
is always UPDATED regardless of Key 
Mapping Settings.  Use this option to 
set fields: Created, Created By, 
Updated, Updated By and Mod Count 
fields.  Can also use this option to set 
fields to NULL using the NULL keyword 
in field mapping.

Migration Method 
(Remedy Target 
Server)

Set & Create; 
Merge;

When the target application is a 
Remedy server, Set & Create performs 
a Modify operation (which triggers 
workflow), whereas Merge performs an 
Import operation which is generally 
faster.
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Defining Logging Options 

On the third tab, the Logging / Reporting options are presented.  Select the 
Logging Level depending on the level of detail and type of execution logging 
required from the following options: 

None, Warning, Error, Information or Detail. 

If there is a particular problem for which you need to generate debug 
information, select the ‘Include Debug Information’ option as well. 

To save the current settings without executing, use the Save Settings button. 

!  

To change the Log File Path, click on the button to the right of the Log File 
Path field, then select a folder from the browser window.  Alternatively use the 
Set Defaults button to set the Log File Path to the Default for the current 
project. 

Notes on Execution Logging 

1. Including Debug information will generate information that can be useful 
to your support team when troubleshooting issues. 

2. All levels of execution logging (other than NONE) will record errors in the 
log. 

3. Logging at the ‘Information’ level is recommended for normal use. 

4. The log entries displayed in the User Interface during execution will only 
list entries at or below the level you have set. Note that not all log entries 
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are displayed in the User Interface, the file log generally shows more 
information. 

5. Note that the logging configuration defined above is for execution logs 
only.  For project design-time logging, use the Project->Logging menu 
option. 

Defining Reporting Options 

By default, a separate migration report is generated for each Form Mapping 
in the project.  If you prefer to have all output for this migration in a single 
report, then deselect this option. 

Additionally, you can define the type of records that are included in the 
reports as follows: 

Refer to the next section for details of how to view and filter reports after 
execution. 

Defining Validation Options 

On the fourth tab, the Validation options are presented: 

!  

Reporting Option Description

Errors Only Generates a report just on any errors found during 
migration;

Unmigrated Entries Generates a report just on records that weren't migrated;

Unmigrated Entries and 
Warnings

Generates a report on records that weren't migrated and 
any Warnings that were produced as part of the 
migration;

All Entries Generates a report on all records in the migration;
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These options are explained in the following table: 

If a missing field is identified during execution, a warning message like this is 
displayed: 

!  

Field Options Description

Business Hours 
Migration 
Restriction Action

Skip Migration; 
Abort Execution; 
Override; 
Prompt for Action;

If migration is attempted during 
business hours for form mapping where 
this is prohibited, either skip the 
migration for this form, abort the 
execution, override the restriction or 
prompt the user to skip, abort, override 
or retry.  If Prompt for Action is selected, 
the execution is paused until the user 
selects an option.  If Retry is selected 
the business hours are checked again 
against the current time to determine if 
the migration can continue.

Unmapped Target 
Field Warning

Set or Unset Only applicable when the source and 
target server are the same type.  
Generates a warning during execution 
for all mappings where source and 
target form/table are the same and if 
any fields are not mapped.

Warn if Source 
Fields are Missing 
on the Target

Set or Unset Only applicable when the source and 
target server are the same type. 
Generates a warning during execution 
for all mappings where source and 
target form/table are the same and one 
or more fields exist on the source form/
table but not on the target.

Ignore Mappings 
with Missing Targets

Set or Unset If no target exists for form or field 
mappings in the project and the 
mapping is not referenced elsewhere, it 
will be excluded from the project 
execution. A warning will be presented 
following initialisation if any such 
mappings are found.
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Defining Advanced Migration Options 

On the fifth tab, the advanced configuration options are presented: 

!  

The migration chunk size defines the number of records that should be 
retrieved from the source server for processing before the next chunk of data 
is selected.  If the chunk size is set too high then there is a possibility that the 
machine where ITSM Bridge is installed could run out of memory before the 
chunk processing is completed.  This would only occur if the records were 
especially large (for example if they had a large number of attachments) and 
the available memory on the host machine was low, (recommended minimum 
is 8GB RAM).  In this case the chunk size should be reduced below the 
default of 10,000 records. 

Note that the chunk size can also be set on individual form mappings where 
necessary (see Form Mapping Options Tab).  The form mapping chunk-size 
setting takes precedence over the Execution chunk size setting defined here. 

Import Set Application 

This is the application where any referenced import sets should reside.  If 
they do not exist, they will be created in this application, provided the ‘Allow 
Import Set Web Service Synchronisation’ option is enabled. 

Allow Import Set Web Service Synchronisation 

This option applies to ServiceNow target servers only. 

If checked, ITSM Bridge will automatically create the required Import Sets, if 
either the ‘Import Set (Field Mappings)’ or ‘Import Set (Scripted)’ migration 
methods are selected (see previous section). 
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If the Import Set already exists, it will be synchronised with any custom fields 
added to the corresponding table mapping. 

If this option is unchecked and an Import Set is not found at execution time 
then a fatal error will be reported. 

Maximum Attachment Size (MB) 

User can define a limit to the size of attachments to migrate. If this limit is too 
high, there is a risk of timeouts in the server calls to perform the migration.  
This limit only applies to ServiceNow target servers. 

Use Server->Server Attachment Migration Method 

This gives the user the option of using the generally faster scripted method of 
migrating attachments between ServiceNow servers.  If unchecked then the  
slower Server->Client->Server method is used. Realistically, the slower 
method would only be used if there was an issue in connectivity between the 
source and target servers preventing the script from working or the user did 
not want to create the attachment migration script on the target server. 

To support this faster attachment migration method, a scripted web service 
called <app name>_migrate_attachments_<version no.> is created on the 
target instance, where <name> is the name of the Import Set Application 
above and version no. is the version of the script. 

This option only applies to ServiceNow -> ServiceNow migrations. 

Select Target Application 

Only applicable when the target server type is ServiceNow.  Sets the 
application scope for all records created on the target server.  The application 
scope is set (for the admin user) when the migration starts and is reset to the 
original value after migration completes. 

Note for Select Target Application, the Application Scope is set for the login 
ID being used to connect to the target server. Note that this may impact 
existing sessions for the same login id, therefore it is recommended to ensure 
no other user or process is connecting with this login during migration. 

Reload Cache on Execution 

If this option is checked, server information such as form/field properties that 
were retrieved at design time, are re-loaded.  This will slow the initialisation 
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stage of the migration but may be required if changes have been made to 
form/field definitions on the server since the project was loaded. 

Starting the Migration 

When you have finished checking all the migration options, click on the 
Execute button on the bottom right of the current window.   This will present 
a confirmation dialogue with the option to cancel or continue with the 
migration. 

Note on Recoverable Errors 

At all points after the initialisation stage of the execution, errors relating to 
network connectivity and/or server availability are trapped and treated as 
‘Recoverable’,  (i.e. it is possible that the operation can succeed if retried). 

Recoverable errors that are found will result in the operation being retried 
after a short period. After 10 such attempts, execution is halted and user input 
is required to continue (Retry/Abort). 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22. Reporting 

ITSM Bridge provides three different types of reports which are accessible 
from the Reporting Menu.  These are described in more detail in the following 
sections. 

Difference Report (for BMC Remedy servers only) 

The Difference Report can be used to compare the field definitions between 
forms on Source and Target servers.  By default, the target form is compared 
with the form with the same name (if it exists) on the Source server. The 
differences identified include: 

 - missing fields on either target or source server. 
 - different field lengths 
 - different field types 
 - different default values 
 - different min/max values (for integer fields) 
 - different mandatory / non mandatory property 
 - different allowed values for enum fields 

The forms can either be added to the report from the full server list (using the 
Add Target Forms button), OR added from the current project (using Add All 
from Project) 

If you choose the Add All from Project button and one or more forms are 
mapped with different names between source and target, then the following 
dialogue appears: 

!  

Select the option that best meets your requirements, then click OK to 
continue.  Note, the default option in this case is to only report on differences 
between matching fields, not fields missing on source/target forms. 
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If instead you choose the Add Target Forms button, use the filter options at 
the top to restrict the list of forms by name prefix, type or whether they are 
mapped or not like this: 

!  

After selecting the required forms, or using the Add All from Project button, 
the report definition window is displayed like this: 

!  

Use the Global Report Options to select whether you want to compare fields 
by matching field name or by matching field ID. 

By default the Field Difference Options are all applied.  These include fields 
that are on the source form but missing from the target, fields that are on the 
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target form but missing from the source and fields where differences in field 
properties are identified between source and target. 

To make changes to the Field Difference Options, select one or more forms 
from the list then use the Apply Report Option settings to modify each value 
as follows: 

 A dash (-) leaves that option unchanged 
 A tick sets the option on 
 A blank sets the option off. 

Use the Apply to Selected button to apply the changes to the selected 
records. 

To Save the current Report Definition, use the Save Definition button. 
To Load a previously saved definition, use the Load Definition button. 
To create a new definition from scratch, use the New Definition button 
(current definition will be overwritten). 

Once you have finished selecting the options you want for your report, click 
on the Execute button to generate the report output. 

The report output is displayed in a separate tab like this: 

!  

A separate row is displayed for every field where a difference is identified.  To 
Filter the results, use the Filter Results button.  The filtering options are 
displayed like this: 
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!  

You can use the Difference Report Filter to filter the output by server 
(source or target), Difference Type (missing, Allowed Values etc), Location 
(form name and field) or Value (the value relating to the difference). 

Additionally you can enter a text value for the Type, Location or Value to 
restrict the output to records that either contain, start with, are equal to, or are 
not equal to the text entered in each case. 

To Save the results to a CSV file for future reference, use the Save Results 
button.  By default, the output is saved in the Reports/Difference Reports  
folder under the current project.  The CSV output file includes the following 
information: 

 Server (Source or Target) 
 Difference Type (Missing Field, Allowed Values etc) 
 Location Description 
 Target Value 
 Source Value 
 Related Target Form 
 Related Source Form 
 Related Field 

To load a previously saved Difference Report CSV file, use the Load Results 
button. 

To view the results on the current project, select the View in Project 
checkbox.  Forms and Target Fields that are different to the corresponding 
Form/Field on the Source Form will be identified with the (!) icon in the Form 
Mapping and Field Mapping lists.  The (!) icon is shown on the left of the 
Form Mapping Lists like this: 
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!  

Clicking on any of the (!) icons displays details of the differences for that form 
mapping like this: 

!  

The (!) icon is shown and on the Field Mapping List like this: 

!  

Clicking on the (!) icon displays more information on the difference identified 
for that field like this: 

!  
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Target Count Report 

The Target Count Report generates a real-time total count of all records for 
each form specified as a target form in the project mapping list.  This can be 
run at any time but is generally run both before and after a migration.  The 
output of the report looks like this: 

!  

Use the Save Report button to save the report output to a CSV file for future 
reference.  By default the report is saved in the Reports/
TargetCountReports folder for the current project. 

Use the Refresh button to re-run the report at any time. 

Migration Reports 

ITSM Bridge provides comprehensive reporting on all migration runs based 
on the options selected in the Logging/Reporting configuration for each 
execution (see previous section). 

It is possible to view reports either for the current project or for any other 
project for which reports have been generated without having to open each 
project separately. 
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To open the report selection window, select Open Migration Report from the 
Report menu or right-click on the project name in the left navigation pane 
and select Open Migration Report. 

After selecting this option, a new window is presented (see below), which 
allows you to either select a migration report from previous executions of the 
current project  OR to select a migration report from a File (from any project).  

If you select the first option, then you must first select the Execution 
Identifier.  This is simply the date and time that the last execution was run for 
the current project.  If you want to view reports from an earlier execution, 
simply select the corresponding execution identifier from the drop-down 
menu. 

!  

Next, select the name of the Form Mapping for which you want to view the 
migration report.  Note that separate reports are generated for each Form 
Mapping in the migration project to make it easier to view and identify errors. 

Finally click on the View button to view the corresponding report. 

Alternatively, you can use the ‘Select Migration Report from File (From any 
Project)’  option to view a report from a different project.  Enter the folder 
directly or use the Browse button on the right to open a folder browsing 
window to select and open the report. 

After selecting the View button to open the report, a new tab is opened in the 
right pane. This pane displays the name of the report file at the top, then 
beneath a list of filtering options and beneath that the report output. 
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By default, the full report output is displayed with a number of column 
headings (see table below).   To sort by a particular column, simply click on 
the column heading.  To reverse the sort order, click on the same column 
heading again. 

To restrict the report to a particular set of records, use the filtering section at 
the top.   Enter one or more values in the Filter fields, then click on the Apply 
Filters button to filter the report output to match the criteria specified.  For 
example, to just view those records where the migration was not completed, 
select “Not Completed’ from the Result Field and click on Apply Filters. 

To return to the full list of records in this report, click on the Clear Filters 
button. 

Report Output Column Headings 

!  

Sample report output (unfiltered): 

Report Column Heading Description

Timestamp The date and time that the migration of this record took 
place

Result Either Created, Updated or Not Completed

Status Either Success, Warning, Skip or Error

Target ID The unique ID of the Target record used to identify which 
record to create/update.

Source ID The unique ID of the Source record used to identify which 
record to migrate.

Message Any associated message text for the migration of this 
record.
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Note on Reports: 

Every report generated is stored as a CSV file in the following location:  

<project root>\reports\Execution<Execution ID>\<form mapping>  

These report files can be opened in a spreadsheet application for more in 
depth interrogation. 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23. Project Logging 

In addition to Execution Logging (see previous section on Execution Options), 
ITSM Bridge provides logging of key design-time activity for troubleshooting 
purposes.  To view the project logging configuration settings, select Logging 
from the Project menu, or right-click on the project name in the left navigation 
pane and select Logging. 

!  

After selecting this option, the following window is displayed: 

!  

To overwrite the log with each execution, select the checkbox ‘Overwrite log 
each session’ 

To view the log by opening in a separate window, click on the View Log 
button.  To clear the log at any time, click on the Clear Log button. 
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If you make changes to any of the logging configuration settings in this 
window, use the OK button to save your changes or click on the Cancel 
button to discard your changes. 
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24. Restricting Migrations to Non-Business Hours 

Defining Restrictions for Form Mappings 

In may be desirable in some circumstances to restrict one or more form 
migrations to non-business hours.  ITSM Bridge allows you to define which 
Form Mappings within a migration project are allowed to run during normal 
business hours and which are not. 

To restrict a Form Mapping to Non-Business Hours, open the Form Mapping 
from the Mapping List, then click on the Options Tab. 

To prevent the Form Mapping from running during business hours, select 
Migrate Out of Hours Only from the Business Hours Restriction menu. 

To allow the Form Mapping to run during business hours, select None 
(default) from the Business Hours Restriction menu. 

Defining Business Hours for the Project 

The business hours are defined for the project as a whole.  To define the 
business hours for the current project, select Business Hours from the 
Project menu. 

 !  
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After selecting Business Hours, the following window is displayed: 

!  

To enter the business hours for a particular day, simply select the 
corresponding row then enter the Start time and End Time.  If a row is left 
blank (like Saturday and Sunday in the example above), then the migration 
will effectively run with no business hours during those days.  All times during 
those days will be treated as non-business hours.   When you have finished 
entering business hours for each day, click on the Apply button to save your 
changes. 
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25. Migrating Attachments 

The method for migrating attachments is different depending on whether you 
are migrating to/from a BMC Remedy server or to/from a ServiceNow 
instance.  Migrating attachments from and Oracle or SQL Server data source 
is not currently supported. 

Migrating BMC Remedy Attachments to another BMC Remedy server 

All BMC Remedy attachment fields are listed in the field-list for the 
corresponding form mapping.  To migrate an attachment field, create a 
simple or lookup field-mapping for the target attachment field and select the 
source attachment field that you want to migrate.  No further configuration is 
required. 

Migrating ServiceNow Attachments to another ServiceNow instance 

To migrate all the attachments for a given table, select the Options tab for the 
corresponding Form Mapping and select the All Attachments option. 
 

When this option is selected, all attachments for records that are themselves 
migrated are also migrated.  

Note: A scripted web service called ITSMBridge_Get_Attachments_3.x.x is 
created on the source instance to support this functionality. 



Copyright Service Management Integrations Limited. 2015-2018.                    
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/
or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. 
BMC and Remedy are registered trademarks of BMC Software Inc.  SQL Server and 
associated logo are trademarks of Microsoft.  Oracle and Java are registered trademarks of 
Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Document Version: 
3.10.2 

Date: Oct 2018 
Page !  119

ITSM Bridge Product User Guide                 !  
——————————————————————————

Migrating BMC Remedy Attachments to a ServiceNow instance 

To migrate all attachments from a Remedy source form to a ServiceNow 
table, the configuration required is identical to the configuration for migrating 
ServiceNow attachments to another ServiceNow instance (see previous 
section). 

To migrate selected attachments from a Remedy source form to a 
ServiceNow instance, select the Options tab for the corresponding Form 
Mapping, select the Selected Attachments option, then click on the Select 
button. The following screen is  then presented: 

!  

Select the attachments that you want to migrate using the Add/Add All 
buttons then click on Apply button to save. 
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Notes on migrating attachments to a ServiceNow instance 

If an attachment already exists on the target record with the same name and 
size then the attachment is NOT migrated.  If an attachment already exists on 
the target record with the same name but different size then the attachment is 
migrated and replaces the original. 

Notes on migrating large attachments to a ServiceNow instance 

!  

When migrating to a ServiceNow instance, the attachment size is limited to 
the value defined in the Advanced Execution Options.  Any attachments 
larger than this are excluded from the migration but included in the migration 
report. 

When migrating large attachments to a ServiceNow instance, if the migration 
takes more than 60 seconds then a time-out will occur. The following 
message may appear in the log and the migration report for the 
corresponding table mapping:  Failed to Post Attachment Data: Failure 
during REST Call.   

If this occurs, you can increase the timeout on the target ServiceNow 
instance by selecting System Definition -> Transaction Quota Rules from 
the menu (requires administrator permissions).  Update this record by 
increasing the default limit (60 seconds) to a suitable limit based on the size 
of your attachments and the speed of your network connection. 

In some situations when migrating large attachments, the migration may 
indicate a failure to connect to the target server after 60 seconds.  If the 
target server is still accessible using a web browser on the same desktop 
client then it may be necessary to increase request_processing_timeout for 
soap.  To do this, navigate to the sys_properties table (requires 
administrator permissions), and search for the entry called: 

 glide.soap.request_processing_timeout 

Update this record by increasing the default timeout (60 seconds) to a 
suitable limit based on the size of your attachments and the speed of your 
network connection 

Warning: It is recommended that the maximum size of any attachment 
does not exceed 32MB and that the attachment size limit be set to a value 
less than or equal to this.
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26. Adding Notes to Form Mappings 

To add or update notes to/on a form mapping simply open the Form Mapping 
from the Mapping List and select the Notes tab: 

!  

After entering or changing the notes for this mapping, click on the Apply 
button to save your changes, or click on the Revert button to reverse your 
changes and revert back to the original text. 
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Appendix A:  Functions available for building Expressions in 
Assignment Mappings 

BUILD_CONDITION (String, String, String); 
Returns: String; 

Function to build a condition expression based on a set of fields and values. 
Conditions generated are intended for use on a ServiceNow target server 
ONLY. 

The first parameter is a comma separated list of field names. 
The second parameter is a comma separated list of field values. 
The third parameter is the ServiceNow conditional operator to be used. 
The values in the lists may be delimited using a double quote (") character. 
The lists of fields should have the same length as the list of values, or be a 
single value (which will be repeated). 
Empty values will be shown as an empty string.  
A maximum of 100 values are supported. 

Example:  
    BUILD_CONDITION('"field1","field2","field3"','"value1","","value3"','^' 

Result: 
    field1=value1^field2=^field3=value3 

DATEDIFF (Timestamp, Timestamp, Integer); 
Returns: Integer; 

Function to obtain the difference between two dates. 

The first parameter is the first date. 
The second parameter is the second date. 
The third parameter is an integer indicating the type of unit to return. 
  4 = Days 
  3 = Hours 
  2 = Minutes 
  1 = Seconds 
If date 1 is greater than date 2, the result will be negative. 
Only whole units are returned. 

Example 1:  DATEDIFF('2015-07-15 12:00:00','2015-07-19 11:00:00',4) = 3 
Example 2:  DATEDIFF('2015-07-15 12:00:00','2015-07-15 11:54:10',2) = -5 
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DATEFORMAT (Timestamp, String); 
Returns: String; 

Outputs a string representing a date/time value formatted to a given pattern. 
The first parameter is the date/time to be formatted. 
The second parameter is the format pattern. 
 The examples below show the characters that can be used in the pattern. 

Example 1:  DATEFORMAT('2015-07-15 12:10:05','dd/MM/yyyy') = 15/7/2015 
Example 2:  DATEFORMAT('2015-07-15 17:10:05','HH:mm:ss') = '17:10:05' 
Example 3:  DATEFORMAT('2015-07-15 13:10:05','hh:mm a') = '17:10:05' 
Example 4:  DATEFORMAT('2015-07-15 13:10:05','MMM d, yyyy h:mm a zz') 
= 'Jul 7, 2015 1:10:05 PM EST' 

LOWER (String); 
Returns: String; 

Function to change a string to lower case. 
The parameter is the source string. 
All upper case characters will be changed to lower case. 

Example:  LOWER('HamBurger') = 'hamburger' 

LPAD (String); 
Returns: String; 

Function to pad a string to a minimum length by adding characters to the start 
The first parameter is the source string. 
The second parameter is the string that will be used as padding. 
The third parameter is the minimum length of the returned string. 
If the string is longer than <length> it will be returned unchanged. 

If the string NULL it will be returned unchanged. 

Example:  LPAD('Hello','-',8) = '---Hello' 
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PROPER (String); 
Returns: String; 

Function to change a string to proper (title) case. 
The parameter is the source string 
The first character of each word will be changed to upper case. 
Words separated by either spaces or '-' characters are supported. 

Example:  PROPER('peter hodson-bridge') = 'Peter Hodson-Bridge' 

REPLACE (String, String, String); 
Returns: String; 

Function to replace all instances of a character sequence with another 
sequence in a source string. 

The first parameter is the source string. 
The second parameter is the character sequence to be replaced. 
The third parameter is the character sequence used in replacement. 

Example:  REPLACE('IT_System','_',' ') = 'IT System' 

RPAD (String, String, Integer); 
Returns: String; 

Function to pad a string to a minimum length by adding characters to the end. 

The first parameter is the source string. 
The second parameter is the string that will be used as padding. 
The third parameter is the minimum length of the returned string. 

If the string is longer than <length> it will be returned unchanged. 
If the string NULL it will be returned unchanged. 

Example:  RPAD('Hello','-',8) = 'Hello---' 
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SNOW_REPLACE_ARS_IMG_TAG (String, String, String, String); 
Returns: String; 

Function to change the image tabs in html originating from BMC Remedy so 
that they reference the migrated ServiceNow attachments. This advanced 
function is intended when migrating BMC Remedy Source HTML strings to 
ServiceNow ONLY. 

It relies on the arattid attributes for the image tag containing the name of the 
image file attachment on the source server. The attachments referenced in 
the HTML must already have been migrated in an earlier form mapping.  

The first parameter is the BMC Remedy HTML string to be migrated 
The second parameter is a comma separated list of previously migrated 
target attachment file names. 
The third parameter is a comma separated list of previously migrated target 
attachment sys_id’s. 
The fourth parameter is a comma separated list of source attachment field 
names, and should include the names of any attachment fields that could be 
referenced in the source HTML string. 

The values in the lists may be delimited using a double quote (") character. 
The lists of target file names should have the same length as the list of target  
attachment sys id’s. The function will search the HTML looking for image 
<IMG> tags. For each one found: 

•   Record the 'src and 'arattid' attribute values; 
•   Use the arattid value to obtain the source file name of the attachment it 

references; 
•   Identify the position of the source file name value in the file names csv; 
•   Look up the attachment sys_id in the attachments ids csv, using the 

position found in the previous step; 
•   Build the new src attribute 

(src=“sys_attachment.do>sys_id=<attachment_sys_id>"; 
•   Replace the existing src attribute; 
•   Remove the ARS specific attributes (arattid, arschema, arentryid) as well 

as any attributes that are not well formed xml; 

All other tags remain unchanged.  
The updated HTML string is returned. 
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STRPOS (String, String); 
Returns: Integer; 

Gives the position of a character sequence within a string. 

The first parameter is the source string. 
The second parameter is the character sequence. 

If the sequence is found, the zero based index of the first instance of the 
character string is returned. If not found, NULL is returned. 

Example:  STRPOS('Hello World','or') = 7 

SUBSTRING (String, Integer, Integer); 
Returns: String; 

Function to obtain a part of a given source string. 

The first parameter is the source string. 
The second parameter is the index of the start character (zero based, 
inclusive). 
The third parameter is the index of the end character (zero based,exclusive). 
If the third parameter is 0, the start character to the end of the string will be 
included. 

Example:  SUBSTRING('Hamburger',4,8) = ‘urge' 
Example:  SUBSTRING('Hamburger',3,0) = 'burger' 

TEXT_AFTER (String, String); 
Returns: STRING 

Function to return all characters following the last instance of the search 
string. 

The first parameter is the source string. 
The second parameter is search string. 

If the first parameter is NULL, NULL is returned. 
If the second parameter is NULL, the first parameter is returned. 

Example: TEXT_AFTER(‘C:\Users\Tony’,'\') = ‘Tony' 
Example: TEXT_AFTER('Hamburger','m') = ‘burger' 
Example: TEXT_AFTER('Hamburger','i') = 'Hamburger' 
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TODATE (String, String); 
Returns: Timestamp; 

Outputs the date/time created by formatting the given string to the given 
pattern. 
The first parameter is the string from which the date/time will be created. 
The second parameter is the format pattern to be used. 

The examples below show the characters that can be used in the pattern. 

Example 1:  TODATE('20150101','yyyyMMdd') = 2015-07-15 00:00:00 
Example 2:  TODATE('07/11/15 17:10','dd/MM/yy HH:mm') =  2015-11-07 
17:10:00 
Example 3:  TODATE('23 Apr, 2018','dd MMM,yyyy') = 2018-04-21 00:00:00 
Example 4:  TODATE('20150609T100000','yyyyMMdd''T''hhmmss') = 
2015-06-09 10:00:00 
Example 5:  TODATE('Jul 7, 2015 1:10:05 PM EST','MMM d, yyyy h:mm a 
zz') = 2015-07-15 13:10:05 

TRUNC (String, Integer); 
Returns: String; 

Function to truncate a string to a maximum length. 

The first parameter is the source string. 
The second parameter is maximum length of the returned string. 

If the string is not longer than <length> it will be returned unchanged. 

If the string NULL it will be returned unchanged. 

Example:  TRUNC('Hello World',8) = 'Hello Wo' 

UPPER (String); 
Returns: String; 

Function to change a string to upper case. 

The parameter is the source string 
All lower case characters will be changed to upper case. 

Example UPPER('Hamburger') = 'HAMBURGER' 
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VALUE_MATCH_REPLACE (String, String, String); 
Returns: String; 

Function to replace all instances of set of character sequences with another 
sequence in a source string. 

The first parameter is the source string. 
The second parameter is the csv list of one or more character sequences to 
be found and replaced. 
The third parameter is the csv list of one or more character sequences to be 
used in replacement. 

The second and third parameters must have the same number of entries or 
an error will occur. Instances of the first value in the search list will be 
replaced with the first value in the replace list and so on for all value pairs.  

Empty string search values are ignored. 

Example:   
VALUE_MATCH_REPLACE('The cat flew over the hill’, ‘"cat", “hill", “over"', 
‘"dog", "river","into"') 

Result: 'The dog flew into the river' 



Copyright Service Management Integrations Limited. 2015-2018.                    
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/
or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. 
BMC and Remedy are registered trademarks of BMC Software Inc.  SQL Server and 
associated logo are trademarks of Microsoft.  Oracle and Java are registered trademarks of 
Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Document Version: 
3.10.2 

Date: Oct 2018 
Page !  129

ITSM Bridge Product User Guide                 !  
——————————————————————————

Appendix B:  Unsupported Field Types 

The following field types are unsupported with the current version of the 
product: 

On ServiceNow Servers: 
 Audio Fields 
 Video Fields 
 Encrypted Fields 

Other field types may require use of assignment mappings to translate data 
into the correct format. 

Appendix C:  Migration of Currency Fields 

Only the following currency codes are currently supported: USD, GBP, EUR, 
JPY, CHF 

Update via a simple mapping to a BMC Remedy currency field: The 
ServiceNow value will retain the currency code and value from the remedy 
value. If the currency code is not supported by ServiceNow, the USD 
functional currency from the BMC Remedy value will be used. If the BMC 
Remedy value does not have a USD functional currency value, the 
ServiceNow value will not be updated. 

Update via a simple mapping to a BMC Remedy int/float/decimal field: 
The ServiceNow value will be set to the numeric BMC Remedy value using 
the USD currency code 

Update via a simple mapping to a BMC Remedy field of any other type: A 
run time error occurs resulting in the record being skipped. 

Update using default value (simple mapping with a default value): The 
value should be suffixed with a currency code(e.g  250 GBP) If not suffixed, 
USD will be assumed. If the currency code is not supported, a design time 
error will occur. 

Update using an assignment:  Arithmetical operations are not supported 
and no functions currently use currency fields. If the currency field is used 
alone, the simple mapping case will be used. If a numeric field or value is 
used, the USD currency code will be assumed. String values in the format 
<decimal> <currency code> are supported. Currency code must be 
supported, otherwise a run time exception occurs. 
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Update using a source lookup query: The BMC Remedy field being looked 
up must be castable to a ServiceNow currency value (i.e Integer, Float, 
Decimal or Currency) otherwise a run time error occurs resulting in the record 
being skipped. 

Update using a target query: If the target value has a currency code, it will 
be used. If not, the USD code will be used. 

Use in target lookup queries: Arithmetical operations are not permitted and 
result in a design time error. Comparison with a ‘current’ currency or price 
field will use the currency code associated with the target value to calculate 
the default currency (USD) value. All comparisons are performed in the 
default currency. 

If the current value uses an unsupported currency code, the query will not 
match any entries, and the ‘No Match’ instruction will apply. Comparison with 
a numeric ‘current’ field or numeric value will assume the default (USD) 
currency. Comparison with a string value is not currently permitted, even if it 
is formatted as a currency value. 

Use in source lookup queries: As for target queries, except that all currency 
codes supported both by the search field and the ‘current’ field. 
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Appendix D:  Migration of Journal and Diary Fields 

ServiceNow -> ServiceNow Migrations: 

To migrate journal entries between ServiceNow instances, create a mapping 
to the Journal Entry Virtual table (see section on Virtual Tables).  This uses a 
script to ensure that all entries are created in the correct sequence using the 
source timestamps and user-ids. It also creates the required audit records so 
that the journal entries are visible in the ServiceNow activity fields. 

BMC Remedy -> ServiceNow Migrations: 

To migrate work-log or other records from BMC Remedy into ServiceNow 
journal fields, create a mapping from the BMC Remedy Work-Log form to the 
Journal Entry Virtual table (see section on Virtual Tables).  This uses a script 
to ensure that all entries are created in the correct sequence using the source 
timestamps and user-ids. It also creates the required audit records so that the 
journal entries are visible in the ServiceNow activity fields. 

ServiceNow -> BMC Remedy Migrations (to BMC Remedy Diary Fields): 

The behaviour of this migration is determined by the Update Method, either 
Set/Create or Merge (set in the Execution Options Dialog).  If Set/Create is 
used, the BMC Remedy server expects a string value, which is appended to 
the diary entry list.  For this reason only String fields are migrated to BMC 
Remedy Diary fields when Set/Create method is set. 

To Migrate Journal fields to BMC Remedy Diary fields, set the Update Method 
to Merge.  (The default method when target server is BMC Remedy).  

Below is a summary of how diary field migrations work for ServiceNow -> 
BMC Remedy Migrations: 

Update 
Method

Source 
Field Type

Target 
Field Type

Result

MERGE Journal Diary Target diary entry list 
replaced with a list of the 
journal entries. Submitter 
and timestamp from the 
source journal entries is also 
migrated.

SET / 
CREATE

Journal Diary Field not updated
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BMC Remedy -> BMC Remedy Migrations: 

The behaviour of this migration is determined by the Update Method, either 
Set/Create or Merge (set in the Execution Options Dialog).  If Set/Create is 
used, the BMC Remedy server expects a string value, which is appended to 
the diary entry list.  For this reason only String fields are migrated to BMC 
Remedy Diary fields when Set/Create method is set. 

Below is a summary of how diary field migrations work for BMC Remedy -> 
BMC Remedy Migrations: 

MERGE String Diary Field not updated

SET / 
CREATE

String Diary New entry will be appended 
to the diary. 
Diary entry submitter will be 
the current user and the 
timestamp will be the 
current date.

Update 
Method

Source 
Field Type

Target 
Field Type

Result

Update 
Method

Source 
Field Type

Target 
Field Type

Result

MERGE Diary Diary Target diary entry list 
replaced with source list

SET / 
CREATE

Diary Diary Field not updated

MERGE String Diary Field not updated

SET / 
CREATE

String Diary New entry will be appended 
to the diary. 
Diary entry submitter will be 
the current user and the 
timestamp will be the 
current date.
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Appendix E:  Migration of ServiceNow Duration Fields 

The following restrictions apply to the migration of Duration Fields: 

BMC Remedy->ServiceNow, Simple Mapping: 

• A string source field is accepted, values should have the following format 
'd hh:mm:ss' otherwise an error will occur; 

• An integer source field is accepted and is interpreted as the total number 
of seconds of the duration 

• A string default is accepted if it has the correct format 'd hh:mm:ss' 

ServiceNow->ServiceNow, Simple Mapping 

• A duration source field is accepted 
• A string default is accepted if it has the correct format 'd hh:mm:ss' 
• Duration fields can also be migrated to a string field 

ServiceNow-> BMC Remedy, Simple mapping 
• Duration source fields can be migrated to an integer. The integer is given 

the value of the total number of seconds in the duration 

Assignments: 

A duration target can be set using an assignment mapping to construct a 
duration string in the correct format. e.g. 

(((((([u_days] + ' ') + LPAD(/u_hours],'0',2)) + ':') + LPAD([u_mins],'0',2)) + ':') 
+ LPAD([u_seconds],'0',2)) 

The use of duration fields in assignment strings is not supported 

Queries: 
The use of the duration field in queries is not supported. 
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Appendix F:  Migration of Images 

Migrating images between BMC Remedy servers 

Images in BMC Remedy applications are stored as file attachments.  To 
migrate an image between two Remedy servers, simply map the 
corresponding attachment fields using a Simple mapping.  If the source 
image is on a different form, use a Lookup mapping instead. 

Migrating images from BMC Remedy to ServiceNow 

Images in BMC Remedy applications are stored as file attachments and in 
ServiceNow they are stored using a separate ‘image’ field type.  To migrate 
an image from a BMC Remedy Server to a ServiceNow instance, use a 
Simple mapping from the BMC Remedy attachment field to the ServiceNow 
image field. 

If the image attachment is not on the current source form, use a Lookup 
mapping to map the required attachment.  For example: 
 

Note that if the image in BMC Remedy is embedded in HTML text then 
special handing is required using the SNOW_REPLACE_ARS_IMG_TAG in 
addition to the attachment migration.  Contact ITSM Bridge support if you 
need to make use of this advanced function. 

Note that in addition to populating the image field in ServiceNow, the image is 
also attached to the target record. 

Migrating images between ServiceNow instances 

To migrate images between ServiceNow instances, use a Simple mapping to 
map the corresponding fields. No additional configuration is required in this 
case. 
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Appendix G:  Restrictions on use of Oracle DB data source 

All functionality described in the body of this document applies to ITSM 
Bridge when used with an Oracle DB source unless specifically excluded in 
this appendix. 

The following restrictions apply to the use of an Oracle DB data source: 

Only the following data-types are supported for field mappings: 

VARCHAR2 
CLOB 
NUMBER 
INTEGER 
DATE 
TIMESTAMP 
INTERVAL 
DECIMAL (Number with scale >0) 
BINARY DOUBLE 
NCLOB 

These can be used in Simple, Assignment, Value Mappings and Lookups 

The use of reference type field mappings is not supported (not to be confused 
with mapping to ServiceNow Reference fields which is supported).  In most 
cases the same result can be achieved using a Lookup mapping. 

The migration of attachments and images is not supported from Oracle. 


